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INTRODUCTION  

This course was developed to introduce OpenRoads Designer CONNECT Edition - OpenRoads Technology tools  

for design and modeling on Florida Department of Transportation (FDOT) projects.  The curriculum was 

developed within the FDOTCONNECT Workspace to provide sample exercises for most of the new Civil Tools 

on a sample project data set.  

COURSE OBJECTIVES 

Participants of this course will be introduced to the newest OpenRoads Technology and a Workflow for 

designing two dimensional (2D) Plans, Profiles, Cross Sections and three dimensional (3D) Models for 

Construction Deliverables.  At successful completion they will have learned how to: 

• Create a Terrain Element from the existing surface to be used as a reference for the project. 

• Develop Existing Feature Terrain Surfaces to be shown on cross sections and used in earthwork calculations. 

• Use Civil Geometry Elements in the design file to calculate and define a proposed centerline of construction 

and while using the built in Design Standards Criteria checking. 

• Use Civil Geometry Elements in the design file to define the roadway features of the proposed design.  

• Apply Civil Cells delivered within the FDOTCONNECT Civil Cell DGN library. 

• Use Civil Geometry Elements in the design file to define the vertical profiles of a proposed centerline. 

• Use the Standard Components and Templates within the FDOTCONNECT Template library. 

• Create a 3D Model of the existing and proposed Roadways. 

• Reference 2D Civil Geometry Elements to a Corridor Model by adding the elements for use as design model 

control lines. 

• Apply varying Typical Section conditions along the project, including: variable medians, special ditches, 

handrail checks, gravity wall placement, slope conditions, left and right turns, etc. 

• Define the Superelevation Standards along a corridor. 

• View Dynamic Cross Sections for review, updates, and design checks along the project before cross sections 

are created for printing. 

• Create and display 3D Models for better designing and visualization. 

• Use the Milling Overbuild and Overlay Components on a project corridor. 

• Apply Corridor Modeling Techniques used for developing driveways and intersection, etc. 
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EXPECTATIONS – WHAT THIS COURSE PROVIDES 

This course provides a standard workflow for designing a project with Bentley Systems OpenRoads Designer 

CONNECT Edition - OpenRoads Technology within the FDOTCONNECT Workspace. Although the majority 

of tools are used throughout, this course does not provide a description of every Bentley Systems OpenRoads 

Designer CONNECT Edition - OpenRoads Technology Civil Tool.  Integrated help for each of the tools can 

be found by selecting FILE then going to the backstage and selecting Help to bring up Bentley’s ONLINE HELP 

or from the Ribbon pick the HELP icon.   

 

FILE > HELP 
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DOCUMENT STYLE  

Style conventions used throughout the course guide are shown in the following table. 

Item Convention Example 

Menu names and 

commands 
Bold N 

(Names separated with > 

symbol) 

• File > Open 

• File > ComSelect > Design 

Dialog box Actions Bold • Click the Apply button. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include box. 

• In the Segment Type list, click Lines. 

Dialog box Field 

Names 
Italic • Key in Hemfield Road in the Alignment 

Name field. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include field. 

• In the Segment Type list, click Lines. 

Key-ins Bold • Key in Hemfield Road in the Alignment 
Name field. 

File Names Italic • Open the file  ALGNRD01.dgn in the 
C:\WorkSets\FDOT\22049555201\Roadway. 

File Paths Non italic • Open the file  _Blank.dgn in the 
C:\WorkSets\FDOT\22049555201 

New Terms or 

Emphasis 
Italic • The Template Library contains templates, 

which represent typical sections of the 
proposed roadway. 

 

We would like to introduce the user to a new workflow terminology using the Ribbon.  If you see a direction like 

this:   

OPENROADS MODELING > GEOMETRY > HORIZONTAL > Lines > Line From Element > Simple Line 

From Element  

This means we are in the WorkFlow of OpenRoads Modeling which has a Tab named Geometry and has tools 

that are located in the Horizontal Group. Now that we are in the right workflow, Tab and Group we may need 

to click on a tool that has more than one option. 
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FILE TYPES 

The Bentley Systems GEOPAK OpenRoads Technology road design process now uses a single source file 

type, the DGN file.  All pertinent design data is stored in the design file. This information can be viewed through 

the Project Explorer and reported on in the Civil Report Browser. 

Below is a brief description of the legacy file types used in GEOPAK which can be imported or exported (i/o) 

with OpenRoads Technology. 

File Type Description: 

• Surface.tin  (i/o) - A binary file, also known as a GEOPAK digital terrain model (DTM),that stores features 

made up of random points, break lines, and boundary data along with triangulated surface model. The features 

and the triangles together represent an existing ground surface. 

• Surface.dat (i) - A binary (or ASCII) file containing string and point information that is used for digital terrain 

model construction. 

• Surface.dtm (i/o) – A binary file, also known as a Roadway Designer digital terrain model that stores features 

made up of components, break lines, and boundary data along with triangulated surface model. The features 

and the triangles together represent either existing ground surface or the proposed roadway corridor model. 

• Template Library.itl (i) - Stores templates and template components. Different components can be assembled 

to build templates, which define the typical sections of a roadway. Only one Template Library file may be 

open for editing at a given time. 

LEARNING RESOURCES 

There are several resources available for learning about the various Bentley Systems OpenRoads Designer 

CONNECT edition OpenRoads Technology tools. Among them are: 

• Bentley Communities: 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openr

oads-designer 

http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-

faqs.aspx 

• Bentley Learn:  

Bentley Institute site is for registered user and may require a Select Server site license to participate:  

https://learn.bentley.com 

• Bentley Product OpenRoads: 

Videos are available on a variety of topics: https://www.Bentley.com  

• YouTube: 

Bentley OpenRoads Videos are available on a variety of topics:http://www.youtube.com/user/BentleyCivil  

• YouTube Search - Google:   

Bentley OpenRoads returns several sites with videos for learning how to apply the technology on project 

specific situations. 

• Production Support Office | CADD (CADD) Website:  http://www.fdot.gov/cadd/ 

Webinar training recordings are available on many of the subjects covered in this manual:   

http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm 

http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection 

https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openroads-designer
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openroads-designer
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
https://learn.bentley.com/
http://www.bentley.com/
http://www.youtube.com/user/BentleyCivil
http://www.fdot.gov/cadd/
http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm
http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection
https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A
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COURSE SUPPORTING FILES 

The exercises for each chapter are independent of one another and can be used without having to complete the 

exercises in previous modules. The exercise files are organized into separate completed Selected zip files for each 

chapter.  All files used in this course are located also at this link:  

http://www.fdot.gov/cadd/downloads/documentation/FDOTRDAnd3DM/FDOTRDAnd3DM.shtm 

INTRODUCING A NEW WORKSPACE  

FDOTCONNECT PREDEFINED SETTINGS 

 

DESIGN FILE SETTINGS: 

  

 

  

http://www.fdot.gov/cadd/downloads/documentation/FDOTRDAnd3DM/FDOTRDAnd3DM.shtm
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FDOTCONNECT WORKSPACE PREFERENCES: 
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FDOTCONNECT FUNCTION KEYS  

FDOTCONNECT Function Key Assignments 

F1 Opens the OpenRoads Designer OnLine Help. Ctrl+F1 Closes all Views except View 1 

F2 Open View 1 (2D Plan) and View 2 (3D Isometric) and fits both views. 

F3 Opens View 3 (2D Plan), closes all View 4, and arranges all Views. 

F4 Open View 1 (2D Plan) , View 2 (3D Isometric), View 1 (2D Plan), View 1 (2D Plan) & 

Fits All views 

F5 Toggles Dim References ON/OFF 

F6 Resets out of any ongoing commands. 

F7 Toggles the Construction view attribute ON/OFF. 

F8 Toggles between MicroStation AccuDraw and Civil AccuDraw. 

F9 Toggles (opens or closes) the Reference dialog. 

F10 Toggles (opens or closes) the Level Display dialog. 

F11 Toggles (opens or closes) the Project Explorer dialog. 

F12 Opens the Create Template dialog. 
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• Function Key F1 – Civil Help 

 

 

• Function Key F2 – Open and Fits Two Views Setup; View 1- 2D Plan, View 2-Isometric 
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• Function Key F3 – Opens View 3; Closes View 4 and Arranges Views 

 

• Function Key F4 – Opens and fits Four View Setup; View 1- 2D Plan, View 2-Isometric, View 3,4 - custom 
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• Function Key F5 – Toggle Dim References 

   

• Function Key F6 – Resets Out of Any Ongoing Commands. 

 

• Function Key F7 – Toggles On/Off Construction View Attributes 
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• Function Key F8 – Toggles Between MicroStation AccuDraw and Civil AccuDraw 

  

• Function Key F9 – Toggles Reference Dialog Open\Close. 

 

• Function Key F10 – Toggles Level Display Dialog Open\Close. 
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• Function Key F11 Toggles Project Explorer Dialog Open/Close. 

  

• Function Key F12 Corridor Modeling, Opens Create Template Dialog. 
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FDOTCONNECT USER CONFIGURATION VARIABLES 

  

FDOTCONNECT DESIGN AND 3D MODELING OVERVIEW 
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GENERAL WORKFLOW AND CHAPTER OUTLINE 

1. Existing Terrain and Existing Features 

2. Design Centerlines Alignments  

3. Prepare 2D Plan Layout  

4. Design Profiles 

5. Define Project Templates 

6. Create 3D Design Model and add 2D References 

7. Create Cross Section View 

8. Define Superelevation and Assign to the Corridor Model 

9. Detail Modeling for Intersections, Median Traffic Separator Nose, Side Roads, 

Driveways, Curbs Ramps, etc. 

10. Prepare Construction Deliverables. 

RECOMMENDED MICROSTATION SETTINGS  

Various tools and settings will be used throughout the workshop. Therefore for quick accessibility, several of the 

dialogs are better docked on the sides the MicroStation view.  

GETTING STARTED 

LAUNCHING FDOTCONNECT FOR OPENROADS DESIGNER  

FDOT Connect can be launched from the FDOT – Roadway and FDOT – ROW icons located in the 

FDOTConnect folder on your desktop.  The first time it is launched, it is important to select the FDOT 

workspace from the workspace dropdown.  

1. Find the FDOT Connect launch icons on your desktop or locate the “FDOTConnect” folder on 
your desktop.  

  

2. Launch FDOTConnect for OpenRoads Designer by double-clicking one of the FDOT icons. 

Note that your FDOTConnect launch icons will vary depending on which Bentley Connect 

Edition platforms you have installed. FDOTConnect will create an icon for OpenRoads 

Designer, an icon for MicroStation Connect Edition (MSCE), and an icon for OpenBridge 

Modeler (OBM) depending on which of these applications is present on your machine during 

installation of the Workstation or Client. (This release of FDOT Connect is the “Alpha test” 

version for OpenBridge Modeler). 
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3. In the Workspace/Workset select screen of OpenRoads Designer, select the Workspace 

selection drop-down menu by clicking on “No Workspace.”  

  

4. Select “FDOT” from the drop-down menu to select the FDOTConnect workspace.  

    

5. From here, you can now create a new WorkSet,,this is done by selecting the drop-down menu, 

being sure to select the FDOT’s “0_WORKSET_TEMPLATE” as the workset template.   
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6. Click “OK” after filling in the Create Workset dialog.  

 

7. After creating a new project using the FDOT Workset Template, you can create new files using 

the FDOT Create File tool.  This tool is launched from within the FDOTConnect workspace, 

so you must first open a file.  The FDOT Workset template includes a blank starting file from 

which to launch the Create File tool.  

8. From the OpenRoads Designer file open dialog, select “Browse” to browse the contents of 

your new workset. 

 

9. Locate “_Blankfile.dgn” at the root of your workset folder structure. Select this file and then 

select “OPEN” to open it. 
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10. When the FDOTConnect Workspace opens, you can locate the FDOT ribbon by selecting the 

“OpenRoads Modeling” workflow from the menu at the top left of the screen. The FDOT tab 

is located at the far right of this ribbon.  Select “Create File” to launch the Create File tool for 

creating FDOT project files.   
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MENU DOCKING 

  

1. Verify that the Civil Message Center tool is already docked on the bottom; if not, select it from 

the General Geometry Task group, dock and unpin.  

   

2. Verify that the Project Explorer is docked on the left side; if not, from the Ribbon select the 

Home tab then in the group named primary click on the explorer icon…Or use the F11 function 

key to toggle ON/OFF the dialog. 
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3. Verify that the Level Display is docked on the right side; if not, from the FDOT-Function Keys 

press F10, dock and unpin.  

 

4. Verify that the Element Information is docked on the right side; if not, this can be brought up 

by selecting Ctrl+I , dock and unpin. 

  

 Many of the dialog settings are stored in user preferences defined in xml data files located in the users 
data folders i.e. C:\Users\rd964vd\AppData\Local\Bentley\OpenRoadsDesigner\10.0.0\prefs. 
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1 CENTERLINE ALIGNMENTS 

INTRODUCTION 

This chapter will introduce three (4) important OpenRoads Technologies for creating geometry/line work 

while designing in FDOTCONNECT.  They are: 

• Feature Definitions 

• Civil Geometry Design Intent  

• Design Standards 

• Annotation Groups 

We would like to introduce the user to a new workflow terminology using the Ribbon if you see a direction like 

this  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line From Element>Simple Line From 

Element  

This means we are in the WorkFlow of OpenRoads Modeling which has a Tab named Geometry, and has tools 

that are located in the Horizontal Group. Now that we are in the right workflow, Tab and Group we may need 

to click on a tool that has more than one option.  

FEATURE DEFINITIONS 

As defined in the Bentley Civil Tools help files: 

“Feature Definitions are used to control symbology, annotation, and various other properties 

that are applied to the geometric elements. .  The feature definitions are used to: 

• Define what the geometric elements actually are. What is being modeled such as curb, 

centerline, edge of pavement, etcetera. 

• Control symbology in various views, including capability to define differing symbology 

in plan, profile, and 3D spaces 

• Define terrain modeling attributes (spot, break line, void, etcetera) 

• Define surface display characteristics 

An extensive FDOT_Standards_Features.dgnlib has been developed for the FDOTCONNECT Workspace to be 

used for all FDOT projects. All elements placed in the design file should have a defined Feature definition. The 

Civil Geometry tools can be set with an Active FDOT Civil Features for element creation and assignment. They 

can be viewed in the Project Explorer and in the Feature Toggle Bar. 
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CIVIL GEOMETRY - DESIGN INTENT 

As defined in the Bentley Civil Tools help file: 

“Design intent builds associations and relationships between civil elements. Object information 

(how, where, and by what method it was created) is stored with the object to insure the original 

intent is retained and honored in the design. If an element is modified, any related elements will 

recreate themselves based on these stored relationships. 

Civil Geometry or rule-base elements are created intelligently as the tools are used and elements are constructed. 

The FDOTCONNECT Workspace and design development workflow is highly dependent on using Civil 

Geometry for the 2D plan layout rather than traditional MicroStation place elements tools. 

CIVIL GEOMETRY DESIGN STANDARDS  

Also known as Design Geometrics and Criteria and as defined in the Bentley Civil Tools help files: 

“Design standards can be used to maintain required curvature and other alignment checks when 

performing geometric layouts. They work at two levels: 

• Provide values for the element creation tools (for example, minimum radius and 

transition lengths) 

• Check the suitability of complex elements (for example, check for kinks in the 

alignment) 

Design standards are very alignment oriented. You may find limited value for using design 

standards for non-alignment computations. 

When a design standard is violated, feedback is provided in two ways: 

• An icon in the graphics on the element that has the problem. Hover over the icon to 

reveal a tool tip report of the error. 

• In the Civil Message Center 

An extensive FDOT_DesignGeometricsCriteria.dgnlib has been developed for the FDOTCONNECT Workspace 

to be used for all FDOT projects. Alignments created in the design file either with Civil Geometry Tools or 

Imported should have a set Design Geometrics Criteria. FDOT Design Geometrics Criteria can be viewed in the 

Project Explorer and in the Design Standard Toggle Bar.  
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EXERCISE OVERVIEW  

In this chapter exercise, the existing roadway Baselines for SR61 and US98 will be imported from a provided 

(LandXML) file. A new Centerline of Construction for the SR61 roadway is required to improve the intersection 

with US98. The new intersection will be located across from the School entrance on US98. It will be a 90 degree 

angled intersection from US98.  The centerline will require a new horizontal curve following the FDM design 

guidelines as follows. In order to provide minimal property impacts to a local business on SR61 the alignment 

will be offset from existing baseline to the west 30 feet and will re-join SR61 at a small skew that does not require 

a horizontal curve. 

 

Design Geometrics and Criteria FDOT Design Manual (FDM), Part 2 Chapter 210  

Design Speed 45 MPH 

Facility Low Speed Desired Length  

Maximum Tangent Deflection w/out curve 1 Degree   Section 210.8.1 

Minimum Horizontal Radius 694 feet  Table 210.9.2 

Minimum Length of Curve 675 feet  Table 210.8.1 

Context Class C3 Max Grade Table 210.10.1 

 

• Low Speed Minimum Length – This will give a minimum Radius at Max Super (emax = .05) 

• Low Speed Desired Length – This will give a desired length of curve at Normal Crown  

Note Refer to the FDM for Tables 

 

1.1 Import Baseline  

1.2 Design New SR61 Centerline  

1.3 Import Side Roads  

1.4 Baseline Side Road Design from BL98 

1.5      Using Annotation Groups to Label Your Alignment Features 
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Exercise 1.1 Import Baseline  

Import Baseline In this exercise, the user will create a new design file and import chains from the LandXML  file 

provided from the survey.  

1. From the desktop FDOTCONNECT folder, double-click on the FDOTConnect for 

OpenRoads Designer icon.  

  

2. Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the 

Actions Group click on the create file.  

OPENROADS MODELING>FDOT>ACTIONS 

3. Create a ALGNRD01.dgn file with the dialog as shown below. 

  

a. From the Create File Dialog box pick the Base Filename of ALGNRD 

b. Select your County, by selecting this the correct coordinate system will be selected. 

c. Click Create - Open File to create the file, ALGNRD01.dgn.  

d. You are now in the ALGNRD01.dgn Click Close.   

e. Navigate to the models Dialog, you will notice that during the creation of the ALGNRD 

a new model of SUPERELEVATION was created. 
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4.  If the SURVRD file exists use the Attach Survey Reference tool which is located on the 

FDOT Tab, with in the Roadway Group. These Tabs and Groups can be found within the 

OpenRaods Modeling WorkFlow.  Otherwise,  skip to step 7.  

OPENROADS MODELING>FDOT>ROADWAY 

  

5. Select the SURVRD01.dgn file. 

 

6. From the Function key F9 (toggles on the Reference Dialog) to view the attached files: 

 

7. From the Function key F9 (toggles on the Reference Dialog) and attach the following files: 

• C://e/projects/survey/TOPORD01.dgn (disregard if SURVRD exists) 

• C://e/projects/rwmap/RWDTRD01.dgn  - Set the Logical Name to RWDTRD 

• C://e/projects/roadway/AERIALS.dgn  - Set the Logical Name to AERIALS 

8. Fit View and Save Settings, select Ctrl F. 

9. Use the OpenRoads Modeling workflow to locate the Geometry Tab, then in the General Tools 

Group is where you will find import tools, Import/Export tool – import Geometry and select 

the Landxml file in the Roadway folder to import alignments. We are looking for the file name 

BL98.xml. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Import 

Geometry 
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a. Navigate to the Alignment > Alignment>BL98 folder.  

b. Click in the  box to select BL98. 

   

c. Click Import.  

d. Repeat this process to import the existing baseline for SR61. The file name of this 

LandXML is EX61.xml. 
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10. Zoom to the intersection of EX-SR61 and US98, hover over the baseline to verify the 

alignment imported in the previous step. You will notice that the Baseline for US98 already 

has a Feature Definition assigned to it. 

 

11. Use Geometry Tab, and the General Tools Group, and then click on the Standards icon bring 

up the dropdown list that for the Set Feature Definition Tool.  OPENROADS 

MODELING>GEOMETRY>GENERAL TOOLS>Standards>Set Feature Definition 

 

a. Set the Feature Type to Alignments. 

b. Set the Feature Definition to Baseline. 

 

c. Select the EX-SR61, then click Reset to set the Baseline feature on the line.  

12. Select the Element Selection to exit the command, you can also do this by the function Key 

F6. 
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Exercise 1.2 Design New SR61 Centerline  

This exercise will use several Construction lines to create the final Centerline as shown below. 

 

➢ ConstLines1 

1. Locate the Driveway into the school off US98 between the baseball field and the parking lot. 

 

2. Now that the new intersection is located, turn the display OFF for the Aerial Reference file. 
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3. Use the Geometry Tab and the Horizontal Group, to select the Line Between Points tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 

 

a. Use Feature Definition Const Lines Blue Dash and a Name of  ConstLines1. You 

will have to add the 1 to the name.  

b. Start a line perpendicular to BL98 and ending at in the middle of the Driveway. Be 

careful not to snap to anything on the second point. 

 

➢ ConstrLines2 

1. Use the Geometry Tab and the Horizontal Group, to select the Simple Line From Element 

tool.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line From Element> 

Simple Line From Element. 
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2. Use Feature Definition Const Lines Blue Dash and Name ConstLines2 

3. First select ConstLines1, then use the AccuSnap to locate the beginning of the line at BL98. 

 

4. Enter a Distance of -2000 feet. Data point in the View to accept the Distance. 

5. Data point to accept Trim None. 

 

➢ ConstrLines3 

1. Use the Geometry Tab and Horizontal Group, to select the Single Offset Entire Element 

tool.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Entire Element 
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2. Use Feature Definition Const Lines Blue Dash and Name ConstLines3.  

3. Data point in the View to create a line -30 feet Offset to EX-61.  

4. Uncheck the mirror option to No, and click in the View.  

 

5. Once the new line is created, turn the Display OFF for the SURVRD with Logical Name 

TOPO in the  Reference dialog.  
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➢ ConstrLines4 

Next step, create a line from the Offset line to intersect the EX-SR61 line at a 1 degree deflection angle. 

1. Find the Bearing Angle of EX-61, select the element and click the Context Menu Description. 

Copy the Bearing value into the buffer space selecting Ctrl C <OR> right-click Copy.         

Note: You may have to right click on the element to make the bearing value active in order to 

copy from it.  

 

2. Use the Geometry Tab and Horizontal Group, to select the Line Between Points tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 

 

3. Use Feature Definition Const Lines Blue Dash and Name ConstLines4. 

4. Start a line at the intersection of ConstLine2 and ConstLine3 (this can be done by selecting 

the intersection snap) then enter a value of 2000 feet for the Length and use the Bearing in the 

buffer as the Line Direction minus 1 degree. 
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5. Use MicroStation Trim to Element and  to Trim ConstLines4 line to intersect EX-61. This 

step will create an interval element with a new Name of ConstLines5. 

 

➢ Verify the Construction Lines Maintain Design Intent 

1. Change the Active Level to Scratch1_dp. Use MicroStation Drawing to Place Circle with 

MicroStation with a center at the end of ConstrLines5 

  

2. Open View 4 and use Copy View from View 1. Zoom into the School Entrance in View 4 

 

3. Move the location of the ConstLines1 and check the end of ConstLines5 to see if the location 

has been corrected.  

 1: Select the first line and Use the manipulator tool  handle in the middle to move parallel location. 
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 2: Select ConstLines5, Use MicroStation Undo/ Redo to see the end change location. 

  

4. Select Ctrl Z to undo change. 

5. (Extra Exercise) Change the Offset Distance of ConstrLines3 from -30 to -40 to verify that 

the end of ConstrLines4 will change.  

6. Select Ctrl Z to undo change. 

➢ Construct a Horizontal Curve between ConstLines2 and ConstLines5 to Meet Geometric 

Standards.  

1. Use the Design Standards Toolbar that is already docked at the top of the screen.  

 

2. Set Active the Design Facility Standard to: Low Speed Desired Length, 45 MPH. 

 

3. Activate the Toggle Active Design Standard icon.   
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4. Use the Geometry Tab and the Horizontal Group to select the Simple Arc tool. This tool can 

be found using the Arcs button then selecting Arcs between Elements Simple Arc 

OPENROADS MODELING>GEOMETRY>Arcs>Arcs Between Elements>Simple Arc  

   

5. Use Feature Definition Const Lines Blue Dash and Name ConstLines6. 

6. Create a Radius between ConstLine2 and ConstLine5 you will notice that setting the Design 

Standard has set a default value of 2083.00’ for the Radius, be sure to change this to 881.00. 

Set Trim/Extend to Both. 
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➢ Make a Longer Driveway into the School. 

1. Select ConstLine1 using the element selection tool. 

2. Select the manipulator for length, click it and change the length from 85 to 105 

 

Note After the line is constructed a Warning icon may appear on the line because the Active Design Standard 
icon is being toggled ON and the tangent length may be less than the minimum 100 feet.  

 

➢ Next, Create a Centerline of All the ConstrLines.  

1. Use the  Geometry Tab and Horizontal Group, Complex by Element tool. 

 OPENRAODS MODELING>GEOMETRY>HORIZONTAL>Complex Geometry>Complex 

By Element 
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2. Create the new Alignment by connecting the elements. Use Feature Definition Centerline and 

Name SR61_CL, with no spaces. Use the Manual Method. 

 

3. Be careful to select at the school side first and near the start of the line.  

 

4. Continue until New Centerline is constructed as shown below.  
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➢ Set a Begin Station Value at the Intersection of BL98 

1. Use the Geometry Tab and Horizontal Group, Start Station tool under the Modify icon. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Modify>Start Station 

 

2. Set a Begin Station value of 700+00 at the intersection of SR61 and BL98. 

 

3. Select the new SR61 Centerline(CL). 

4. Use AccuSnap to locate the Intersection with BL98 and data point to accept. 

5. Enter 70000 and select Enter <OR> data point to accept.  

 

  



Chapter 1 _______________________________________________ CENTERLINE ALIGNMENTS - Design New SR61 Centerline 

FDOT Roadway Design and 3D Modeling ©2019 FDOT  1-15 

➢ Describe the New Centerline Geometry 

1. Use the Geometry Tab and General Tools Group, Horizontal Geometry Report tool under 

the Reports icon.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Reports>Horizontal Geometry 

Report 

 

2. Select the SR61_CL Centerline. Use the settings below at the prompt to generate the report 

shown. 
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 If the Stationing format is not displayed correctly, In the Bentley Civil Report Browser, select Tools Format 
Options 

 

 



Chapter 1 _______________________________________________ CENTERLINE ALIGNMENTS - Design New SR61 Centerline 

FDOT Roadway Design and 3D Modeling ©2019 FDOT  1-17 

➢ Save the SR61 Centerline to a Landxml for a back up. 

1. Use the Geometry Tab and the General Tools Group, to select the Export to Native tool and 

save the SR61_CL Centerline to a Landxml  file.  

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Export 

Geometry 

2. This will bring the Export Dialog up which gives you the option to export as a LANDXML 

 

3. Select the Alignment you wish to export, select Version 1.2 for export, when prompted save 

as SR61_CL.xml 
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Exercise 1.3 Import Side Roads  

1. Use the Geometry Tab under the General Tools Group, to select the Import Geometry tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>GENERAL 

TOOLS>Import/Export>Import Geometry 

 

2. Select the following LandXML(FRIENDSHIP.xml)  file: Friendship, Friendship2.  click the 

Import button. 

  

3. Notice from the LandXML a Feature Definition for CenterLine is defined for each alignment.  
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Exercise 1.4 Baseline Side Road Design from US98 

In this exercise Civil AccuDraw is used to help construct a side road centerline on BL98. 

1. OpenRoads AccuDraw and Civil AccuDraw should never be toggled ON at the same time 

because both use some of the same Shortcut Key-ins. Toggle OFF the OpenRoads 

AccuDraw. 

 

2. Use Geometry Tab and the General Tools Group, to select the Civil Toggles icon to call Civil 

AccuDraw tool to activate the Civil AccuDraw toolbar. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Civil Toggles>Civil 

Accudraw 

 

3. Click on the Mode Station-Offset to toggle ON. 

 

4. Use the Geometry Tab and Horizontal Group, to select the Line Between Points tool to create 

a Centerline perpendicular to the BL98 at Station 39+00 for a Length of 80 feet used as a side 

road centerline. Here are the steps to use Civil AccuDraw with the Station Offset option: 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 
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 On the cursor prompt, tab to the offset field and use the Shortcut Key-in o, and select 
the reference line BL98. The cursor will now track the station and offset.  

 

 

a. For the first data point, set the Snap Locator button to Perpendicular, and select on 

the BL98. 
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b. For the second point tab to the Station field in the AccuDraw Cursor Prompt dialog, 

enter Station value 39+00, select Enter to lock in on the station. 

 

c. Tab to the Offset field in the AccuDraw Cursor Prompt dialog, Enter Offset value 80, 

select Enter to lock.  

 

d. Data point in View to place the point. Repeat these steps for the Centerline at Station 

36+40.0 
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Exercise 1.5 Using Annotation Groups to Label Your Alignment Features  

1. In the ALGNRD file that has been created in the previous exercises. From the OpenRoads 

Modeling WORKFLOW navigate to the DRAWING PRODUCTION TAB and the 

Annotations Group. There are two icon buttons for Annotating. 

 OPENROADS MODELING>DRAWING PRODUCTION>ANNOTATIONS 

 

a. Element Annotation – This will annotate the element and remove the element 

Annotation Group. 

 

b. Model Annotation – This will annotate all the elements in the model and remove the 

element Annotation Group. 

 

2. From the Drawing Production Tab and the Annotations Group, Select the Annotate Element 

button then following the prompts by the cursor. Select SR61 Centerline (optional you may 

select multiple alignments if you like) The n reset the tool by right click.  

OPENROADS MODELING>DRAWING PRODUCTION>ANNOTATIONS>Annotate 

Element 
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3. You have now just Annotated your Alignments.  

  

a. If you Navigate to the FDOT Tab on the Ribbon, in the Actions Group will be the 

Filters Icon Button with a Drop Down list. 

 OPENROADS MODELING>FDOT>ACTIONS>Filters 

  

b. From this list you will now be able to control what levels will be displayed for the 

Annotation Group.  
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c. When you first Annotate the alignments in the level display all levels will be turned 

on. When using the Level Filters for annotation group be sure to change the Drawing 

Scale to match the applicable scale. 

 

 

Example: For drawing scales from 1”=10’ to 1”=60’ use the Level Filter for Display Only 100 Foot Major 

Annotations   
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2 2D PLANIMETRICS 

INTRODUCTION  

This chapter will continue to use the OpenRoads Technology for Horizontal Geometry. Rather than use 

traditional MicroStation element creation tools, these exercises will provide participants with practice using the 

Civil Tools.  Using Civil rule-based Feature Definitions assures design intent is incorporated into the two 

dimensional (2D) plan layout. This will, in turn, prove valuable when design changes or “what if scenarios are 

needed or tested.   

This chapter also introduces two (2) important new OpenRoads Technologies for creating geometry / line 

work while designing in FDOTCONNECT.  They are: 

• Civil AccuDraw  

• Civil Cells 

CIVIL ACCUDRAW 

As defined in the Bentley Civil Tools help files: 

“Use Civil AccuDraw to allow precise input of points, whether the points are physical points or 

end points of linear geometry. The Civil AccuDraw values can be persisted as rules on the points 

by locking both values in the Civil AccuDraw input. Several methods can be used, among them 

are: 

• Distance and Direction, to set the order of ordinate entry to distance then direction, 

with both sharing a common point of origin. 

• Dist-Dir, to set the order of entry to distance for the first ordinate then direction for the 

second ordinate, without a common point of origin. 

• Dist-Dist, to set the order of entry to distance for the first ordinate then distance for the 

second ordinate, without a common point of origin. 

• XY, to set the order of ordinate entry to X-axis then Y-axis, with the two sharing a 

common point of origin. 

• DX DY, to set the order of ordinate entry to the difference in X coordinate then the 

difference in the Y coordinate, with the two sharing a common point of origin. 

• Station-Offset, to set the order of ordinate entry to station identification then offset 

value, with both sharing a common point of origin 

 The delivered methods are those configured by default. These defaults can be edited, removed, 

or additional methods may be added. 
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CIVIL CELLS 

As defined in the Bentley Civil Tools help files: 

“A civil cell is a collection of civil elements - geometry, templates, and terrain models - which 

can be placed repeatedly in a design. The collection of civil elements will have been created 

relative to one or more reference elements. When you place the civil cell, you choose the new 

reference elements, and a new collection of civil elements is then created relative to them. A civil 

cell can therefore be thought of as a copy of the original collection of civil elements, relative to 

the geometry of the new reference elements. Civil cells can be 2D or 3D. They can consist of 2D 

(plan) elements only, or 3D elements (2D elements with profiles), and can include terrains, 

linear templates, area templates, and simple corridors. 

When the new civil elements are created, all of the rules associated to them are also created. 

This means that the new civil elements retain their relationships, both with each other and with 

the reference elements, and therefore know how to react when these relationships change. In 

addition, the Civil and MicroStation toolsets can still be used on the new civil elements, to adjust 

and further refine the design as required, because there is no difference between a civil element 

created by a civil tool, and one created by placing a civil cell. 

Civil cells can save a lot of time and effort, because they replicate the complete series of steps 

needed to create the civil elements. They also help to ensure compliance with design standards, 

by making a civil cell available to the design team.  

EXERCISE OVERVIEW 

2.1 Preparation for 2D Plans 

2.2 BL98 Milling Limits 

2.3 BL98 Widening 

2.4 BL98 Widening Taper Line 

2.5 For SR61 New Construction Template Lines 

2.6 Add Right Turn lane on BL98 

2.7 Add the School Entrance Right Turn Lane off BL98 Intersection 

2.9 Create/Edit the Intersection Curve Radii 

2.9 Trim Back Sidewalk and Curb Lines to the Curve Radii 

2.10 Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii 

2.11 Create a Custom Civil Cell for Other Radii 

2.12 Place Left Turn with Traffic Separator 

2.13 Place Right Turn Island 

2.14 For BL98 Intersection Crosswalks Lines 

2.15 Create BL98 Turnouts 

2.16 For BL98 Intersection Shoulders 

2.17 For Friendship Intersection 
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Exercise 2.1 Preparation for 2D Plans 

1. Create the DSGNRD01.dgn file from the FDOT Tab under the Actions Group using the Create 

File Tool (This tool is always the starting point to create QC compliant design files for your 

workset/project.  

OPENROADS MODELING>FDOT>ACTIONS>Create File 
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Exercise 2.2 BL98 Milling Limits 

In this exercise the existing pavement edge lines from the TOPORD or SURVRD file are copied to be used as 

the Milling Lines for the proposed improvements. If the SURVRD does not exist and you only have a  TOPORD 

skip to step 5. 

1. Use the Attach Survey Reference from the FDOT Tab within the Roadway Tools 

Group.  (This tool will attach a SURVRD file 4 times with different Logical names of 

TOPO, GDTM, UTEX, DREX which apply to different level filters.)  

OPENROADS MODELING>FDOT>ROADWAY>Attach Survey Reference 

 

2. Once the SURVRD is attached, open your Reference Dialog (Function Key F9) and 

Detach the reference files with logical names of GDTM, UTEX, DREX. This will only 

leave the TOPO. 

3. Now we need to copy or merge the elements that are on the PavtAsphalt_ep level. 

This can be done by using the Copy Reference Levels tool from the FDOT Tab with 

in the Roadway Tools Group  

OPENROADS MODELING>FDOT>ACTIONS>Copy Reference Levels 

 

  



Chapter 2 _______________________________________________________________ 2D PLANIMETRICS - BL98 Milling Limits 

FDOT Roadway Design and 3D Modeling ©2019 FDOT  2-5 

4. This will open a dialog for the Copy Reference File Levels tool. On the left side of the 

dialog choose PavtAsphalt_ep level. Then click on the plus  to add the level to 

the right side of the dialog. Click the process button to merge/copy the elements with 

this level in to the file. 

 

5. This step if no SURVD Exists Use OpenRoads References (Function Key F9) to 

attach and display the TOPORD01 and RWDTRD01 Reference files. 

 

6.  Use OpenRoads Level Display to turn OFF all the TOPORD01 Levels except the 

PavtAsphalt_ep.  

7. Use the  Geometry Tab and the Horizontal Group, Line Between Points tool.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 
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8. Create a PavementMilling ML line across the existing intersection of SR61 and BL98. 

  

9. Use OpenRoads Break Element on the PavtAsphalt_ep line string elements where the new 

PavementMilling(ML) line intersects. 

 

10. Repeat these steps for the other side roads along BL98. 
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11. Create a Selection Set of the PavtAsphalt_ep by level. This can be done with the right click 

function of the mouse, by holding down and Selecting All On Level By Element. Then 

selecting an element.  

 

a. Subtract out of the Selection Set the Intersection lines at SR61; these will not be 

PavementMilling ML lines. 
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b. Also subtract out of the Selection Set the Intersection lines at Friendship Road. 

 

12. Use the Geometry Tab and the General Tools Group, Click on the Standards button to bring 

up a drop down that has the Set Feature Definition tool.  

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Standards>Set Feature 

Definition 
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13. Data point to change the elements to the Feature Definition, Pavement Milling ML. 

 

14. Change the Selector tool back to New and verify the New Feature Definition by hovering over 

a line until the Context Menu displays. 
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Exercise 2.3 BL98 Widening 

Before we start, the ALGNRD will need to be attached as a reference into the DSGNRD file. Making sure when 

you attach the ALGNRD it is the Default Model. With a Detail scale of 1”=50’.   

In this exercise, the proposed Pavement Lines used for widening on BL98 are created at the following locations: 

 

 

 

 

 

 

 

1. Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located 

in the Offsets and Tapers button.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

  

a. Select the BL98 line at the prompt to Locate Element. 

  

 
START 

STATION 
OFFSET LENGTH 

FEATURE 

NAME 

1 28+00 16 feet 500 feet          SW_EOPA 

2 33+00 32 feet 600 feet SE_EOPA 

3 30+00 -24 feet 300 feet NW_EOPA 

4 33+00 -24 feet 1000 feet NE_EOPA 
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b. Fill in the Single Offset Partial dialog as shown below. 

   

c. Data point in the View to accept the Offset. 

d. Data point in the View to accept Length. 

  

e. Data Point in the View to accept No at the Mirror option prompt. 

2. Repeat this procedure for each of the Pavement Asphalt EOPA widening lines diagram and 

table above.  
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Exercise 2.4 BL98 Widening Taper Line 

In This exercise a tapered Pavement Asphalt EOPA line off BL98 is created at the following location.  

Select Alt to enter the End Station. 

 

 Toggle On the Civil AccuDraw. 

1. Use the Geometry Tab and the Horizontal Group, to select Variable Offset Taper tool located 

in the Offsets and Tapers button.  

OPENROADS MODELING>GENERAL >HORIZONTAL>Offsets and Tapers>Variable 

Offset Taper 

 

2. Select the BL98 element to offset from. 

3. Enter the Station at 39+00 and select Enter to lock the value. 

4. Tab to the Offset, enter 20 and select Enter to lock the value.  

START 

STATION 

START 

OFFSET 
END STATION END OFFSET 

FEATURE 

NAME 

39+00 20 feet Alt to end Station Lock Snap Nearest EOPA_TAPER 
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5. Data Point in the View to set the first point. 

 

6. Select Alt key to lock the End Station value. 

7. Set the AccuSnap tool to Nearest, hover over the right Pavment Milling ML until the Snap 

Mode displays. 

 

8. Data Point to place the second point and complete the command.   
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Exercise 2.5 For SR61 New Construction Template Lines 

First, it is necessary to create a Template Limits line for the Project Typical FDM Civil Cell. This is a Construction 

type element which is used to define the Begin and End Station limits.  

1.   Use the Geometry Tab and the Horizontal Group, to select the Single Offset Partial tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

2. Create a Feature line, Const Lines Green. 

a. Select the SR61 Centerline CL. 

b. Set the Offset to 10.00. 

c. For the first point, set AccuSnap to Intersection and select the intersection of SR61 and 

BL98. 
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d. For the second point, zoom out to the first intersection after the end of the SR61 curve 

and snap to the right Pavement Milling ML of existing SR61 <OR> Key in Station 

716+50. 

 

 Use Intersect Snap and to place first point and Key Point snap for the second point.   

3. Use the Model Detailing Tab and the Civil Cells Group, to find the Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 
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4. Navigate to the FDOT_2D-FDM_Exhibit_Lines.dgnlib, and select 306-5 Exhibit civil cell to 

place. 

 

a. Click OK and follow the prompts to complete the Place Civil Cell command. 

b. Locate Reference Element, select the Green Const Line. 

 Use the tab key to after clicking on an element to get to the last place Green Const Line. 

c. Reset to Skip View Alternates. 

d. Data point to accept Civil Cell Placement 

.  
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5. Change the Front Sidewalk Utility Strip Width to 0ft and verify that the Sidewalk Width is set  

to 6ft,  

a. Select the Sidewalk Front FSW Feature and zoom to find the Context Menu near 

the middle of the element. 

 

b. Change the SidewalkFront Dimension from 4 to 0. 

c. Verify that the SidewalkBack is set to 6.  

d. Repeat this for both sides of the roadway.  
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Exercise 2.6 Add Right Turn Lane on BL98  

This exercise uses Civil Cells to add a right turn lane to the BL98. 

1. Use Model Detailing Tab and the Civil Cells Group,  Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

   

2. From the Place Civil Cell dialog, navigate to the FDOT _2D-Intersection_Details.dgnlib and 

select Right Turn Lane. 

 

3. At the prompt, for the first Reference, select the widening Pavement Asphalt EOPA line. 

4. For the second Reference, select the SR61 Right EOP Out Pavement Asphalt EOPA. 

5. Reset to Skip Elements to View Alternatives. 
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6. Data point to accept Civil Cell Placement. The right turn lane is added. 

 

7. Edit the storage length for first Right Turn Lane placed, select the tangent line and change the 

Length from 200 to 500 feet. 

 

8. Use OpenRoads Trim to Intersection to correct the Pavement Asphalt EOPA lines. 

  



2D PLANIMETRICS - Add the School Entrance Right Turn Lane off BL98 Intersection ____________________________ Chapter 2 

2-20 ©2019 FDOT  FDOT Roadway Design and 3D Modeling 

Exercise 2.7 Add the School Entrance Right Turn Lane off BL98 Intersection 

1. Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located 

in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

2. Create the side road Pavement Asphalt EOPA opposite SR61 left offset -23 feet.  

a. For the beginning, snap to beginning of SR61.  

b. For the end, snap to the BL98 widening line end point at SR61.  

c. Uncheck Mirror to set to No. 
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3. For the opposite side, use the Geometry Tab and the Horizontal Group, to select Single Offset 

Partial tool located in the Offsets and Tapers button.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

4. Create the side road Pavement Asphalt EOPA opposite SR61 Left Offset 39 feet.  

a. For the beginning, snap to beginning of SR61. 

b. For the end, snap to the BL98 widening line end point at SR61.  

c. Uncheck Mirror to set to No. 

 If necessary, Let the tool place the line on the opposite side and edit it after it is placed  

 

5. Add another Right Turn Lane Civil Cell on the opposite side of the intersection. 

 

a. At the prompt, for the first Reference, select the widening Pavement Asphalt EOPA 

line. 
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b. For the second Reference, select the intersection Pavement Asphalt EOPA line. 

 

c. Data point to accept Civil Cell Placement. The Right Turn Lane is added. 

6. Click on the Select Tool Set icon to exit the Place Civil Cell command <OR> F6 Function 

Key. 

 

7. Edit the storage length for the second Right Turn Lane placed, select the tangent line and 

change the Length from 200 to 365 feet. Verify the Change the lane width is -16 feet. 
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Exercise 2.8 Create/Edit the Intersection Curve Radii 

1. Use the Geometry Tab and the Horizontal Group, to select the Simple Arc tool located in the 

ARCS button then the drop down of Arc Between Elements.  

 

1. Create/Edit the Curve returns. 

2. Select Feature Definition, Pavement Asphalt EOPA to place remaining curve radii.  

3. Follow the cursor prompt to select the two Roadway Pavement Asphalt EOPA reference 

lines.  

 Rotating the view along the BL98 BaseLine will set the Top of the screen as North giving a quandrant as 
shown below. 

 Select the two Pavement Asphalt EOPA in each quadrant. Use the value shown and trim both for each of 
the following quadrants:  NorthWest 110 feet, 

NorthEast 60 feet,  
SouthWest 60 feet,  
SouthEast 60 feet 
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Exercise 2.9 Trim Back Sidewalk and Curb Lines to the Curve Radii 

This exercise takes advantage of design intent to modify the curb and sidewalk lines off SR61 to the new curve 

radius end point. 

1. Select the LT_PVT_EOP_IN line (Pavement Asphalt EOPA Feature). 

 

2. When the Context Manipulators display, zoom into the beginning point and select the Start 

Station handle OR the Station value to move the end. 
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3. Drag the handle while zooming out and select the End Radius point to move the point.  

 

4. Notice the results. The curb and sidewalk move as one because of the built in design intent 

relationship. 

 

5. Repeat these steps to move the RT_PVT_EOP_IN line  (Pavement Asphalt EOPA Feature) 

back to the curve radius on the right Roadway. 
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Exercise 2.10 Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii 

1. Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool.  

OPENROADS MODELING>MODELING DETAILING>Place Civil Cell 

  

2. Navigate to the FDOT _2D-Curb_Lines_And_Endings.dgnlib and select the Curb Lines Type 

F civil cell. 

  

3. At the prompt, select the NW_EOPA radius line, reset to View Alternates and then data point 

to accept the Civil Cell Placement. 
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4.  Navigate back to the Place Civil cell dialog select the SideWalk Civil cell from the the FDOT 

_2D-Curb_Lines_And_Endings.dgnlib. Place this civil cell off of the back of curb line that you 

just placed in the previous step. 

  

5. Edit the SidewalkBack line from -5 to -6 feet from the SidewalkFront line of the element. 

Also the SidewalkFront needs to be set from -4 to 0 feet. 
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Exercise 2.11 Create a Custom Civil Cell for Other Radii 

1. From the Model Detailing Tab and the Civil Cells Group, select the Drop Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Drop Civil Cell 

   

2. Select the SidewalkLines Civil Cell in the View and data point to drop the Civil Cell. Repeat 

this for the Curb Civil Cell. 

 Move the cursor over the curb or sidewalk lines to see it highlight 

 

3. Use Civil Cells, Create Civil Cell tool. This can be found in the Model Detailing Tab and the 

Civil Cells Group of the Ribbon.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Create Civil Cell 
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a. Enter the Civil Cell Name: Custom CurbandSidewalkLines. 

 

b. Data point to accept the new Name. 

c. At the prompt, locate Reference Element and select the NW_EOPA line. 

 

d. Reset to Locate Reference Element. 

e. Reset to Optional Reference. 

f. Data Point to accept Civil Cell. 

4. Use the new Civil Cell to place for the other Radii; use Place Civil Cell, This can be found in 

the Model Detailing Tab and the Civil Cells Group of the Ribbon.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell. 
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a. If the Custom CurbandSidewalkLines is not active, navigate to the Active DGN and 

select it from the list. Click OK. 

 

b. At the prompt, select the NE_EOPA Radius line. 

 

c. At the prompt, select Element to View Alternatives, move the cursor over the EOPA 

line and click on the Arrow to reflect the Civil Cell to the correct side. 
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d. Reset to View alternates.  

e. Data Point to accept the Civil Cell Placement. 

 

5. Repeat these steps to place the Custom CurbandSidewalkLines Civil Cell on the NE EOPA 

Radius. 

  

6. Leave the SE Radius without curb and sidewalk. 
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Exercise 2.12 Place Left Turn with Traffic Separator 

1. Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

a. Navigate to the FDOT _Intersections.dgnlib and select Left Turn with TS civil cell. 

 

b. At the Locate Reference Element Centerline, select the BL98 line in the View. 
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c. At the Locate Reference Element Pavement Asphalt EOPA, select the 

RT_PVT_EOP_IN line in the View. 

 For the direction of travel l, this is always the left median EOP line 

 

d. Click on the Arrow of both Reference Elements to View Alternates, when the Green 

Turning Radius and Traffic Separator are both in the correct place, Reset to skip. 
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e. Data point to accept the Civil Cell Placement and view the left turn lane on SR61 at 

BL98 Intersection. 

 

2. Use OpenRoads Trim to Intersection tool. A quick way to find a tool is to use the search 

ribbon.  
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3. Trim the curb median elements at the begin taper as shown. 

 

4. Use OpenRoads Trim to Element tool. Which can found in the Drawing Tab, and the Modify 

Group 

 

5. Trim the elements at the Curb Median lines at the Traffic Separator as shown, leave the green 

line. 

 



Chapter 2 _________________________________________________ 2D PLANIMETRICS - Place Left Turn with Traffic Separator 

FDOT Roadway Design and 3D Modeling ©2019 FDOT  2-37 

6. View the placed left turn, change the Turning Radius from 100 feet to 75 feet.  

 

7. View the placed left turn, change the Storage Length from 200 feet to 300 feet.  

 Select the green line, then select the length text.  
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8. Zoom to the Turning Radius Offset Dimension, change the value from -1 feet to -4 feet.  
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Exercise 2.13 Place Right Turn Island 

1. Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

2. Navigate to the FDOT_2D-Intersection_Details.dgnlib, select Right Turn Island. Click OK. 
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3. Select the first Pavement Asphalt EOPA lines.  

 

4. Select the second Pavement Asphalt EOPA line. 

 

5. Reset to Skip Alternates. 
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6. Data Point to accept the Civil Cell. 

 

➢ Change the Right Turn Island Parameters 

1. Change Const Lines Blue Dashed Arc Radius from 110 feet to 126 feet. 
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2. Check Const Lines Blue Dashed Begin Arc Offset is -18 feet. 

   

3. Check Const Lines Blue Dashed End Arc Offset is -16 feet. 
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4. Change the straight Const Lines Blue Dashed SR61 EOP Offset from 1 foot to -16 feet. 

 

5. Check Const Lines Blue Dashed BL98 EOP Offset is -16 feet. 
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6. Change Island EOPA Offset from the Const Lines Blue Dashed BL98 from -5 feet to -2 feet. 

 

7. Change Island EOPA Offset from the Const Lines Blue Dashed SR61 from 1 foot to 6 feet. 
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8. Change Island Radii to 4 feet. 

 

9. Change the Island ingress Offset -4 feet and Island Egress Offset -3 feet. 
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10. Move the Offset handles to the Radius Point. 

 

11. Change the Active Level to Miscellaneous0. 

  

12. Use the OpenRoads Crate Region Flood tool, this tool can be found by switching to the 

Drawing Workflow and then the Home Tab and with in the Groups Group will be the Create 

Region  

DRAWING>HOME>GROUP>Create Region 
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13. Select the Center of the Island, and then data point to accept the closed element. 

 

14. Use the OpenRoads Select tool to view the properties of the new island. Record the Area 

_____. 
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15. View the modified Right Turn Island. 
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Exercise 2.14 For BL98 Intersection Crosswalks Lines 

1. Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located 

in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

2. Create a Partial Offset line from BL98 -52 feet across the intersection. Use Feature Definition 

Const Lines Blue Dash and Name ConstLineA. 

 

3. Use Geometry Tab and the Horizontal Group, to select the Line Between Points tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 
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4. Create a line from the curve center to the midpoint of the Island Radius EOP.  Use Feature 

Definition Const Lines Blue Dash and Name Line B. 

 

5. Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located 

in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 
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6. Create a Partial Offset line from SR61 across the intersection.  Use Feature Definition Const 

Lines Blue Dash and Name ConstLineC.  

 Snap to the mid-point of the radii. 

 

Note Use these lines in later exercises to place 3D Sidewalk Ramp Civil Cells.  
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Exercise 2.15 Create BL98 Turnouts 

In this exercise the additional rural turnouts can be added to BL98. 

1. Use the Geometry Tab and the Horizontal Group, to select Single Offset Entire  

Element tool located in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Entire Element 

  

a. Select the CenterLine of the second Turnout. (This Turnout is at Sta. 39+00.00 of 

BL98) 

  

b. Accept the -20 feet Offset and Mirror. 

  



Chapter 2 _____________________________________________________________ 2D PLANIMETRICS - Create BL98 Turnouts 

FDOT Roadway Design and 3D Modeling ©2019 FDOT  2-53 

2. Use the Geometry Tab and the Horizontal Group, to select the Simple Arc tool located in the 

ARCS button then the drop down of Arc Between Elements.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Arcs>Arc Between Elements>Simple Arc 

 

a. In the Simple Arc tool set Trim/Extend to Both, then set the Radius to 25.0’. Be sure 

to set a Feature Definition of Pavement Asphalt EOPA. Then place the Radius on both 

sides.  

 

b. Change the Geometry to fit the existing driveway. 

 Use the centerline snap and dimensions to modify the location, length and angle. Use the Offset 
Pavement Asphalt EOPA Dimensions to change the width. 
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3. (EXTRA Exercise) Repeat the steps above to create an addition Turnout as shown below 

<OR> use the Civil Cell, FDOT_2D-Intersection_Details.dgnlib, and Side Road Turnout.  

4. First place the Side Road Centerline make sure to go back into the ALGNRD file to adjust the 

centerline feature.  
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Exercise 2.16 For BL98 Intersection Shoulders 

This exercise uses the Pavement Asphalt EOPA to create the 5 feet Shoulder Paved PSHLDR Offset lines.    

1. Use the Geometry Tab and the Horizontal Group, to select Single Offset Entire  

Element tool located in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single Offset Entire 

Element 

 

2. Set the Offset to 5 feet and the Feature Definition to Shoulder Paved PSHLDR. 

  

3. Select the Pavement Asphalt EOPA lines from the previous steps. 

4. Repeat these steps to add the remaining Shoulder lines for the widening along BL98. 

5. View the intersection below for complete details. 
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Exercise 2.17 For Friendship Intersection 

1. Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

a. From the Place Civil Cell dialog, navigate to the FDOT_2D-

Intersection_Details.dgnlib and select Rural Side Road Turnout. 

 

b. Add Rural Side Road Turn Out civil cell to both sides of the Intersection with 

Friendship and Friendship 2 Centerlines.  

c. Use the trim commands located in the Drawing Tab and the Modify Group, to clean 

the extra curb line and sidewalk lines across the intersection. 

OPENROADS MODELING>DRAWING>MODIFY>Trim to Element 

d. Change all Radii to 35 feet. 

e. Change Friendship2 Side Road Offsets to 20 feet. 
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f. Change Centerline Length to 100 feet. This step will need to be done in the ALGNRD 

File. 

 

2. Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

a. From the Place Civil Cell dialog, navigate to the FDOT_2D-

Intersection_Details.dgnlib and select Left Turn w/ Traffic Separator Median. 
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b. For the first Reference element, select the Friendship Rd Centerline. 

 

c. For the second Reference element, select the left median Pavement Asphalt EOPA 

line. 
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d. Reset to Skip Alternates and data point to accept Civil Cell Placement. 

e. Change the turning Radius to 50 feet. 

f. Change the turning lane storage length to 300 feet. 

 

3. Use OpenRoads Trim to Element tool. This can be found using the Drawing Tab and the 

Modify Group. You can also use the Search on the Ribbon. 

OPENROADS MODELING>DRAWING>MODIFY>Trim to Element 
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4. Move the LT_PVT_EOP_IN to the beginning of the Traffic Separator. 

 Use the Const Lines Green as the cut element 

 

5. Use OpenRoads Trim to Element tool. This can be found using the Drawing Tab and the 

Modify Group. You can also use the Search on the Ribbon. 

OPENROADS MODELING>DRAWING>MODIFY>Trim to Element 

 

6. Trim the Curb and EOP lines to the beginning of the median Taper line. 
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7. (EXTRA Exercises) Complete the Intersection with Civil Geometry tools as follows below: 

a. Add Curb lines for each of the Radius.  

b. Trim Sidewalk lines into the Radius Curb lines. There is no sidewalk along SR61 north 

of Friendship Road. 

c. Add Pavement Asphalt EOPA Taper lines from the Intersection Radii at Friendship 

to the End Station of SR61 11 left. 

d. Add Shoulder Paved PSHLDR lines to both sides along the Taper. 
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3 PROFILES 

INTRODUCTION 

This chapter will continue to use the OpenRoads Technology Civil Tools, Vertical Geometry.  These exercises 

will provide participants with practice using the Civil Tools.  Using Civil rule-based Feature Definitions assures 

design intent is incorporated into the vertical geometry layout. This will be beneficial for design when changes 

need to be reflected and considered throughout the development process. This will be beneficial for designs when 

alternatives need to be evaluated throughout the development process. 

This chapter introduces important new OpenRoads Technologies for creating vertical geometry line work 

while designing in FDOTCONNECT workspace.   

OPEN PROFILE MODEL  

The Open Profile Model generates an OpenRoads View that presents the desired feature in profile thus enabling 

the Vertical Geometry tools to interact with the chosen feature. 

Open the Civil Tools Task pane to the Vertical Geometry section then click the Open Profile Model icon. Move 

the cursor into the Workspace and note that it is accompanied by a command prompt requesting that you, "Locate 

Plan Element". Select the element with which you wish to work in profile. The cursor is now equipped with a 

prompt that says, "Select or Open View". Data point or left-click in it a view to present a profile of the selected 

element.  If no other view is open, click one of the view icons on the View Groups toolbar then click again in the 

new View. Vertical Geometry tools can then be used to edit/create vertical profile data in the design. 

EXERCISE OVERVIEW 

3.1  Preparation for SR61 Profile 

3.2 Create SR61 Profile 

3.3 Edit SR61 Profile 

3.4 BL98 Profile 

3.5 Friendship Profile 

  



PROFILES - Civil Geometry - Design Intent ______________________________________________________________ Chapter 3 

3-2  ©2019 FDOT FDOT Roadway Design and 3D Modeling 

CIVIL GEOMETRY - DESIGN INTENT 

As defined in the Bentley Civil Tools help file: 

“Design intent builds associations and relationships between civil elements. Object information 

(how, where, and by what method it was created) is stored with the object to insure the original 

intent is retained and honored in the design. If an element is modified, any related elements will 

recreate themselves based on these stored relationships. 

Civil Geometry or rule-base elements are created intelligently as the tools are used and elements are constructed. 

The FDOTCONNECT Workspace and design development workflow is highly dependent on using Civil 

Geometry for the 2D plan layout rather than traditional MicroStation place elements tools. 

 

Design Geometrics and Criteria FDOT Design Manual (FDM), Part 2 Chapter 210 

Design Speed 45 MPH 

Facility Low Speed Desired Length 

Maximum Tangent Deflection w/out Curve 1 Degree   Section 210.8.1 

Minimum Horizontal Radius 694 feet  Table 210.9.2 

Minimum Length of Curve 675 feet  Table 210.8.1 

Context Class C3 Max Grade Table 210.10.1 

• Low Speed Minimum Length – This will give a minimum Radius at Max Super (emax = .05) 

• Low Speed Desired Length – This will give a desired length of curve at Normal Crown. 

Note Refer to the FDM for Tables 
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Exercise 3.1 Preparation for SR61 Profile 

1. Open the ALGNRD01.dgn that was created in Exercise 2.1.    

C:\WorkSets\FDOT\22049555201\roadway. 

2. From the Function key F9 (toggles on the Reference Dialog) to view the attached files: Turn 

the display off on all the reference files except the SURVRD file with a logical name of 

GDTM. This file will be used to create Profiles of the Existing Ground. 

 

Note If the SURVRD file exists, the SURVRD01 -GTMRD logical can be used 

3. Once you have the turned off the SURVRD files, we now need to set the terrain Active. To do 

this select the boundary to bring up the context menu and select the second icon in the menu. 

  

Note Setting the terrain to Active will create a new Model that is 3D we will use this Model to view our Profiles 
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4. To set up the correct views to design profiles we will use the View Controls located with the 

right click and hold function of the Right mouse. Right Click and Hold on the mouse and 

navigate to the View Control then arrow over to bring up a second dialog to find different view 

control functions select on the (3 Views Plan/Profile/3D) then follow the prompts by the cursor 

to complete. 

 

5. At the cursor prompt, select the OK then it will ask you to select a plan element this will be 

the SR61 Centerline. Once you are done your view windows should look like this. 
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Exercise 3.2 Create SR61 Profile 

In this exercise, several Vertical Geometry tools are used to create a proposed profile for SR61. 

1. Use the Geometry Tab and the Vertical Group of the OpenRoads Modeling WorkFlow.  

OPENROADS MODELING>GEOMETRY>VERTICAL 

 

 

2. From the previous exercise select View 4 to make the Profile window active. 

 

3. Use the  Geometry Tab and the Vertical Group, to select the Define Profiles by Best Fit tool 

that is located within the Complex Geometry pull down.  

OPENROADS MODELING>GEOMETRY>VERTICAL>Complex Geometry>Define Profile 

By Best Fit 
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a. At the cursor prompt, data point to Make Complex Element option.  Enter the Profile 

Name , SR61-PR, and then data point on the green line in the profile. 

 

b. Follow the prompts to enter the Best Fit Parameters as shown. Make sure to pick the 

Feature Definition of CenterLine. 
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4. Using the Design Standards Toolbar that is already docked at the top of the screen. 

  

5. On the Design Standards Toolbar, using the second drop down list navigate to the C2T C3 

C4 C&G (FDOT_DesignGeometrics Criteria Design Library and select 45 MPH.  Toggle On 

the Active Design Standard. 

 Be sure to set the left field (Horizontal Design Standard) in order to set the right field (Vertical Desgin 
Stnadard)   to 45 MPH 

  

6. Use the Design Standards Toolbar,to select the Set Design Standard tool. 

  

a. At the prompt, select the Best Fit Profile created in the previous steps.  The profile 

now has a Vertical Design Standard rule placed on it. 

b. Using the Element Select Tool,  select the profile element and view its properties in 

the Element Information dialog. 
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7. Use the  Civil Message Center tool that is located on the Geometry Tab and General Tools 

Group in the Standards drop down menu.  

 

a. The Civil Message Center dialog displays to view the results.  

Note It may be docked at the bottom of the screen, click on the Tab 

  

b. In the Civil Message Center dialog, select on the MicroStation tab. This will toggle 

Off all the general messages for MicroStation and leave only Error messages and 

Warnings in the list. 

  

c. In the Civil Message Center, review the Errors and Warnings. 
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d. Select the first error, then right click over the error and select Zoom To from the 

popup box. 

  

e. Notice the Error is now centered in the profile view.  Hover the cursor over the Error 

icon to display the Error Message description. 

  

Note The values are given in whole stations, i.e. 3.5 station equals 350 feet. 

8. Since there can be a number of different  situations for both the horizontal and vertical curve 

depending on Context classification and Desi.gn Speed, we will now set the vertical in the 

Explorer Dialog.  

a. Using the Explorer Dialog (Function Key F11) if you  do not have it docked. Navigate 

to the OpenRoads Standards Tab then click on Standards to open the current file you 

are in to see the Design Standards Category to view the Design Standard applied the 

Alignments  in the file. 
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b. Select the Horizontal Design Section to see which design standard is applied to the 

Alignment, next select the desired speed. Now using the Ctrl+I keys to bring up the 

properties dialog lets link a vertical design speed to the horizontal. 

 

9. Use the Design Standards Toolbar that is docked to toggle on the Set Design Standards. 

 

10. At the prompt, select the Best Fit Profile created in the previous steps.  Notice the Error icons 

are no longer displayed. 
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Note A new tool to OpenRoads Designer is the Table Editor Tool. This tool can be found on the Geometry Tab 
and the Common Tools Group. With this tool a selection of the alignment (Horizontal or Vertical) will bring 
up a table for easy editing. 

OPENROADS MODELING>GEOMETRY>COMMON TOOLS>Table Editor 

 

 

Exercise 3.3 Edit SR61 Profile  

This exercise changes the profile using Civil AccuDraw and MicroStation Modify Element. 

➢ Edit the Best Fit Profile  

In order to edit this profile, because it was created from the “Profile by BestFit” the rule must first be removed. 

1. Select the Profile Element and hover over the element to display the Context Menu.  

 

2. Select the Convert to Profile Rule tool.  
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➢ Delete PIs 

1. Use MicroStation Modify, Delete Vertex tool. This tool can be found in the Drawing Tab 

and the Modify Group 

OPENROADS MODELING>DRAWING>MODIFY>Delete Vertex 

 

2. Zoom to the beginning of the Profile and delete the first two Vertical Elements. 
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➢ Create Profile with Place Vertical Line 

New vertical civil profile elements are added to match the existing profile across US98. 

1. Use Geometry Tab and the Vertical Group, to select the Profile Line Between Points tool 

located in the Lines Tools. 

OPENROADS MODELING>GEOMETRY>VERTICAL>Lines>Profile Line Between Points 

 

2. Place Line Elements on the Existing Ground points to trace the Profile across BL98. 

Note This is not exact, simply trace a few lines.  

 

3. Continue using the Profile Line Between Points tool 

a. Begin at the edge of the existing pavement or connect to the proposed profile line from 

the step above.  
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b. In the Profile Line Between Points dialog, check the length and slope, length of 16 

feet and slope of -2%. Click a data point in the view to create the line as defined in 

the dialog.  

   

 

c. Using Line Between Points to join the two profiles, place another Profile line between 

the “16’ at 2%” line and the Best Fit Profile. 
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➢ Profile by VPI’s 

1. Zoom to the Beginning of the profile, Use the Geometry Tab and the Vertical Group, to select 

the Profile Complex By VPI or PI tool located in the Complex Geometry tool Group. 

OPENROADS MODELING>GEOMETRY>VERTICAL>Complex Geometry>Profile Complex By PI 

 

2. Toggle OFF the Active Design Standard, set the Curve length to 50 feet. 

 Check that the Vertical Curve Type is set to Parabola 

 

3. Start by snapping to the Beginning Point on the ground and complete the Profile Segment as 

shown below. 

 This is not exact, snap to 3 points 
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4. Zoom to the End of the Profile, select the Line and move the last End Point to snap to the 

Existing Ground. 

 

 Click on the solid ball manipulator at the end of the line to move it in both directions 
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➢ Complex Profile Elements 

1. Use Geometry Tab and the Vertical Group, to select the Profile Complex by Elements tool 

located within the Complex Geometry tool Group. 

OPENROADS MODELING>GEOMETRY>VERTICAL>Complex Geometry>Profile 

Complex By Elements 

 

2. Key-in the name SR61_PR on the dialog and Start at the Beginning Profile line and create a 

new Connected Profile. 

 On the Profile Complex by Element tool setting, enter the Feature Name. This is the Profile Name assigned 
to the Profile. 
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➢ Profile Report 

1. Use the Geometry Tab and the General Tolls Group, to select the Profile Report tool located 

within the Reports tool Group. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Reports>Profile Report 

   

<OR> With the Profile selected, hover over the element to display the Context Menu and 

select the Profile Report. 
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2. The Bentley Civil Report browser displays the Vertical Alignment Review Report for the 

Profile. Close the Civil Report browser. 

 

3. Use Geometry Tab and the Vertical Group, to select the Set Active Profile tool.  

 

<OR> With the Profile selected, hover over the element to display the Context Menu and 

select Set Active Profile.   

Note The ALGNRD file is your single source for both your Horizontal and Vertical Geometry. This file is now 
more important than ever in your design. This file will be referenced in to your DSGNRD and MODLRD 
files to control the 2D Planimetrics (DSGNRDxx.dgn) and your Corridor (MODLRDXX.dgn). 

➢ Optional Export Profile 

1. Use the Geometry Tab and the General Tools Group, to select the Export Geometry tool 

located within the Import/Export tool Group. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Export Geometry 

 

 Always check that the profile has a Feature Name before saving to the LandXML file 

2. Select the SR61 Horizontal Alignment and save as SR61_Alignment.xml for a backup. 
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Exercise 3.4 BL98 Profile 

1. With the BL98 alignment selected in the Plan View, hover over the element to display the 

Context Menu and select the Open Profile Model. (Optional Method - Using the Right Click 

Menu under View Control navigate and pick 2 Views Plan\Profile then follow the prompts to 

setup a Plan and Profile views.) 

2. Select View 3 to view the Existing Ground Profile for the mainline BL98 Centerline. 

 

3. With the Profile selected, hover over the element to display the Context Menu and select the 

first icon Properties 

4. In the name field enter BL98_EX 

 

5. With the Profile selected, hover over the element to display the Context Menu and select Set 

As Active Profile.  
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6. Use the Geometry Tab and the General Tools Group, to select the Export Geometry tool, select 

the BL98_EX plan element and save as a LandXML file. (Ex. BL98_EX.xml).  

 OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Export Geometry 
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Exercise 3.5 Friendship Profile 

1. With the Friendship alignment selected in the Plan View, hover over the element to display 

the Context Menu and select the Open Profile Model. (Optional Method - Using the Right 

Click Menu under View Control navigate and pick 2 Views Plan\Profile then follow the 

prompts to setup a Plan and Profile views.) 

 

2. Select View 3 to view the Existing Ground Profile for the mainline Friendship Centerline. 
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3. With the Profile selected, hover over the element to display the Context Menu and select Set 

As Active Profile.  

  

4. Repeat the steps for Friendship2 Rd. 

5. Open View 2 using the F2 Function Key to see the 3D alignment cernterlines for the project 

(Optional Method - Using the Right Click Menu under View Control navigate and pick 2 

Views Plan\Profile then follow the prompts to setup a Plan and Profile views.) 

6. Notice the 3D lines displays in View 2. 
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4 BASIC CORRIDORS MODELS 

CORRIDOR MODELING OVERVIEW 

As defined in the Bentley Civil Help:  

“The Corridor Modeling toolset is a group of highly interactive commands to create new design 
surfaces that represent a new roadway or other type of surface. Tools for creation, modification, 
management, and report functions are supported. 

Corridor Modeling tools aggregates a variety of civil data. The geometry is created with the 

Horizontal and Vertical Geometry tools, while the existing ground is defined by a MicroStation 

mesh or Civil Terrain Model. Plan view elements, such as edges of pavement, shoulders, curbs, 

etc. can be 2D or 3D. Superelevation information is defined within a design file using standards 

or imported data. Templates are utilized from one or more template libraries. 

Reference files can be used extensively with Corridor Modeling. On a simple project, the data 

may be all in one file; larger projects may have geometry in one file, plan view graphics in a 

second, terrain in another, superelevation in a fourth and the actual model in a fifth. All files 

can reference the others, to present a complete picture of the project.  

When working with Corridor Modeling, you can draw in 2D or 3D. When using 2D (such as for 

plan-view graphics), a 3D view is automatically created and maintained. For example, when a 

vertical geometry element is initially defined for a horizontal geometry element, the Default-3D 

model is created, if there isn’t one already. The 3D baseline (combination of horizontal and 

vertical element) is drawn into the 3D model. As template drops are added, and progressed, they 

are added to the 3D model automatically.  

When starting to create a corridor, basic information can be used. A single template can be 

used, along with preliminary geometry and a high level terrain model. As the design progresses, 

more detail can be added. Instead of a single template drop, perhaps more templates better 

define the roadway. Transitions can be added to smoothly move from one template to another. 

There may be multiple roadways all interconnected using the target aliasing tools. All the while, 

as changes are made, the corridor model is updating, so you see up-to-the minute results. Simple 

projects may not require all the tools, and a basic corridor model may be sufficient. But all the 

tools are available to handle basic to complex, small-scale to large-scale projects. 

The following are minimum requirements to use Corridor Modeling. 

• Civil horizontal element  

• Civil vertical element  

• Template stored in a template library 

A terrain model is not required for corridor modeling. If the template includes end conditions and no terrain 

model is defined, the software generates as much of the model as possiblebut will not complete the end condition 

that ties to ground and no error message is given. 

Corridor models are built at an interval, which determines the level of detail of the model. OpenRoads essentially 

takes the typical section stored in the template and places it every 25’ (or whatever the interval is set to) along 

the alignment in order to build the 3D model. The FDOT CADD manual section 8.4.7 sets forth the maximum 

required intervals for a corridor, depending on the Context Classification of the roadway. Corridors can certainly 

be built at a more frequent interval, but this is at the expense of more computing power (RAM, disk space, and 

CPU). To optimize the model, the interval spacing should only be made tighter than the maximum when needed. 
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For this project, the Context Classification is C3C. An excerpt from the table in the CADD manual is shown 

below, showing the corridor interval requirement for C3C. The interval can be set to the tangent requirement as 

long as the design stage used decreases the interval spacing on curves. 

Maximum Corridor Frequency Interval Spacing (Feet) 

Context Classification Tangent Curve Intersection 

C3C 20 10 5 

 

CORRIDOR MODELING PLANNING 

It is recommended to plan out the 3D modeling approach on a project.  Some have referred to this a Model 

Management Plan.  This plan will attempt to outline the following: 

• Determine how to break up the project into logical independent corridors 

• Determine which sections of the project are needed for detail modeling and surface modeling 

• Determine the files and filenames to be used for corridors and details.  

Note The project 3D Model may be in separate files or all combined into one file.: The FDOT file defined to be 
used for Corridor and Detail Models is MODLRDxx.  

Below is a sample diagram of a typical Model Management Plan: 

 

EXERCISE OVERVIEW 

4.1 Prepare to Create Corridor Model for SR61 

4.2 Create Corridor, SR61 

4.3 Create Template, SR61 End Conditions 

4.4 Add Corridor Point Controls, SR61 

4.5 Add Corridor References, SR61 

4.6 Variable Medians, SR61 Templates 

4.7 Change Corridor Feature Definition, SR61 

4.8 Add Corridor Key Stations, SR61 

4.9 Review Corridor Objects, SR61 
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Exercise 4.1 Prepare to Create Corridor Model for SR61 

1. (Optional) Extract the 22049555201(6).zip file in the c:\Worksets\FDOT folder. 

2. Open the MODLRD01.dgn file of the c:\Worksets\FDOT\22049555201\roadway\ folder in the 

FDOTConnect - Roadway Workspace in OpenRoads Designer. 

3. The SURVRD01, ALGNRD01, DSGNRD01, and other files are already referenced. 

4. Use the Terrain tab, Set Active tool.  

 

5. At the cursor prompt, select the Terrain Boundary green dashed line from the attached 

SURVRD01 reference file. This will set the terrain model as Active. 

6. Move the cursor over the SR61 Centerline Feature and verify an Active Profile. 

 



BASIC CORRIDORS MODELS - Prepare to Create Corridor Model for SR61 ___________________________________ Chapter 4 

4-4 ©2019 FDOT FDOT Roadway Design and 3D Modeling 

7. Use the Corridor Modeling, Create Template tool. 

 

 Use the F12 function key to access the Create Template Dialog. 

8. Verify that the correct Template Library is loaded. Close the Create Template dialog. 

 

9. To set up the Views for viewing the 2D Plan and 3D Model simultaneously in the FDOTSS4 

Workspace, Select the F2 Function Key on the keyboard.  This will open an Isometric View of 

the project. 
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Exercise 4.2 Create Corridor, SR61 

1. Use the Corridors, New Corridor tool. 

 

2. Select the SR61 Centerline in the Plan View when the “Locate Corridor Baseline” prompt 

comes up. 

3. Reset to accept the Active Profile.  This profile resides with the SR61 Civil Feature Centerline.  

4. Enter the Corridor Name, SR61, in the Create Corridor dialog.  
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5. Data point to accept the Name of the Corridor, SR61. The corridor is created AND the 

integrated Create Template Drop dialog launches.  

Note Once a Corridor is created, a shape boundary is placed in the Plan View representing its outline.  This 
shape is initially placed on the CorrHndlStg1_dp level.  It has several properties which can be seen by 
clicking on the shape and choosing first icon. One of the properties is the Feature Definition (Design Stage).   

  

6. Once the Create Template Drop dialog is opened, first select the corridor template to be 

placed on the corridor. Either use the icon on the dialog <OR> select ALT down arrow to 

pick a template. 
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7. Find the SR61 Inside template in the Corridor Templates folder of the active Project Template 

Library. Select it and click “OK.” 

 

8. Data point to accept the Template and move to the next setting.  

9. Continue to define the Create Template 

Drop dialog information entering and 

accepting the following for the SR61 

Corridor: 

a. Start – Use keypoint or intersect 

snap click to the ML line on 98, 

Station 700+23.62 as shown on 

the right. 

b. End – type in Station 715+00 as 

shown below. 

c. Set the Drop Interval to 20 as 

shown below. 
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10. Upon completion of the Corridor Processing 

bar in the lower right hand side of the 

OpenRoads status bar, the 3D model will 

be displayed in View 2. 

 

Note Once a Template Drop is created, a shape 
boundary is placed in the Plan View 
represent its outline. This shape is initially 
placed on the TmpDrpHndlStg1_dp level. It 
has several properties which can be seen by 
clicking on the shape and choosing first icon. 
Properties include the Template Drop 
Interval and the Template Name. 
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➢ Turn 3D Reference File Display Off in the Plan View 

At times the line work in the Plan View can become confusing with 3D lines over top of the 2D lines. This View 

can be simplified by turning the 3D Model Reference file display Off. 

1. Data Point somewhere in View 1 to make it active. 

2. On the OpenRoads Level Display dialog, navigate to the Ref. MODLRD01.DGN Default-

3D file. 

3. Right click on the file and un-check the Display option. 
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Exercise 4.3 Create Template, SR 61 End Conditions 

Splitting the template allows more flexibility when adding driveways and side streets, as the end condition 

(outside) template can change at those locations without affecting the mainline. The template for the previous 

exercise only extended to the edge of pavement and did not include curb. In this exercise we will add the curb 

and the end conditions. 

1. Use the Corridors, New Corridor tool. 

2. Select the SR61 Centerline in the Plan View when the “Locate Corridor Baseline” prompt 

comes up. 

3. Reset to accept the Active Profile.  This profile resides with the SR61 Civil Feature Centerline.  

4. Enter the Corridor Name, SR61 R, in the Create Corridor dialog.  

5. OpenRoads will continue on to the Create Template Drop command. Either use the icon on 

the dialog <OR> select ALT down arrow to pick a template. 

 

6. Pick the SR61 R template in the Corridor Templates folder of the active Project Template 

Library. 
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7. Continue to define the Create Template Drop dialog information entering and accepting the 

following for the SR61 Corridor: 

a. Start – Snap to the end of the curb radius return on the right side of SR 61 at the T 

intersection, Station 701+00, as shown below. 

 

b. End – Snap to the beginning of the curb radius return on the right side of SR 61 at the 

intersection, Station 714+26.67, as shown below. 

 

c. Set the Drop Interval to 20 and accept the remaining prompts. 
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8. Repeat Steps 1-7 for the left side. 

a. Name the Corridor SR 61 L and pick the SR 61 L Template. 

 

b. Select the start and end points of the template drop based on the curb radius return 

points on the left side of the roadway. The stationing is listed below: 

i. Start – Station 701+34.00 

ii. End – Station 714+29.06 

9. The corridor models will display in the 3D 

View but will be on top of the previously 

placed pavement model. This will be 

addressed in Exercise 6.4.  
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Exercise 4.4 Add Corridor Point Control, SR 61 L and R 

1. Use the Corridors, Edits>Create Point Control tool. 

 

2. Identify the Corridor Boundary handle for the SR 61 R corridor. Continue to define the 

Create Point Control dialog information. 
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3. Enter and accept the following for the SR61 R Corridor: 

o Start Station Lock to Start 

o End Station Lock to End 

o Control Description RT_EOP 

o Point  RT__PVT_EOP_OUT 

o Mode Both 

o Control Type Corridor Feature 

4. For the Corridor, select a handle on SR 61 corridor developed for the inside. 

5. For the Reference Feature, select from the drop down list or select the RT__PVT_EOP_OUT 

line on the SR 61 corridor (inside) in the 3D view, as shown on the right. 

6. Accept the defaults for the remaining items. The 3D view will update to move the curb and 

sidewalk to match the edge of pavement of the SR 61 corridor model. 
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7. Repeat Steps 1 through 4 to set a point control for the SR 61 L corridor, with the following 

differences in the dialog: 

o Control Description: LT_EOP 

o Point: LT_PVT_EOP_OUT 

8. For the Reference Feature, select from the drop down list or select the LT__PVT_EOP_OUT 

line on the SR 61 corridor (inside) in the 3D view, as shown on the right. 

 

9. Repeat Step 6 to complete the point control. The model should look like below in the 3D view. 
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Exercise 4.5 Add Corridor References, SR61 

Corridor References are related to the template points having a Horizontal Feature Constraint to control the 

location of the point on the corridor. They are 2D graphical Civil Features that need to be added to a corridor.  

For the SR61 corridor a selection of median Civil Features are used for template external references.   

1. The SR61 template is designed to target Curb Gutter Type E lines in the median. Hover the 

cursor over one of the median lines to verify that it has the Feature Definition of Curb Gutter 

Type E. 

  

2. Create a selection set of the following 12 features in the plan view: 

o 2 – Pavement Asphalt EOPA lines in the median 

o 4 – Pavement Asphalt EOPA taper lines in the median 

o 2 – Curb Gutter Type E lines in the median 

o 2 – Curb Gutter Type E taper lines in the median   

o 4 – TS Conc Type I 4 ft Wide lines in the median 

 Modeling the TrafSeparator level, do not add the Nose Radius Element to the Selection Set. This will be 
modeled in Chapter 9 with a 3D Civil Cell. 

3. Use the Corridors, Add Corridor References tool. 

 

4. Identify the Corridor handle and then data point to add the 

selected lines as listed above to the corridor. 

5. Once the Reference Lines have been added, the Corridor will 

automatically process to include the new Horizontal Feature 

Constraints. The median features will come in several feet 

above the pavement, as intended on the template. This will be 

resolved in the next exercise. 
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Exercise 4.6 Variable Medians, SR61 Templates 

The FDOTConnect.itl file contains some FPM Exhibit Templates which are delivered with variable medians 

included. The median can vary with the following conditions or component sets: 

o Curb Median with or without Left Turns 

o Crossovers at Intersections 

o Traffic Separators with Left Turns 

To properly operate the median condition templates, consider the following: 

• The various median component sets have a parent end condition search lines that targets plan features; e.g. 

Curb Gutter Type E, Pavement Asphalt EOPA. 

• Each of the median components sets are displayed ONLY if the target is found. This is by the Parent/Child 

relationship of the Template components. 

• The LT and RT PGL Handles, or the LT and RT PGL In points, control the overall width of the median and 

can be modified to fit any project. 

• Many of the median components have Horizontal Feature Constraints (HFC) defined to locate the 2D civil 

features and the horizontal range will need to be modified to fit the project. 

➢ Add Parametric Constraint for Variable Median, SR61 Template  

The templates used have variable median conditions built within that needs to be set in place for the corridor.  

1. Use the Corridors, Edits>Create Parametric Constraint tool. 

 

2. Identify the Corridor Boundary handle. Continue to define the Create Parametric 

Constraint dialog information. 
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3. Enter and accept the following for the SR61 Corridor:  

Start Station  Alt for Begin 

Stop Station  Alt for End 

Constraint Label V_Offset 

Start Value   0.0 

Stop Value   0.0 

 

4. The variable median conditions are placed at the correct location vertically.  This will ensure 

the median is at the correct elevation for the next exercise. 
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Exercise 4.7 Change Corridor Feature Definition, SR61 

The FDOTConnect Workspace includes several Corridor Feature Definitions to help with various tasks for 

Design and 3D Modeling. Depending on the active Feature Definition, processing the Corridor will take longer.  

To optimize model performance, it is recommended that designers wait to change the Feature Definition until 

later in the design process, as each definition is set up with multipliers that decrease the corridor interval spacing.  

For example, the Design stage might be utilized for a 60% submittal, while the Final stage might be utilized for 

the 90% and final submittals. 

1. Open the Explorer pane from the Home tab or with the F11 Function Key. 

 

2. Select to expand the OpenRoads Standards section and expand the Standards option list. 

3. Expand Corridor under Libraries > Feature Definitions > Feature Definition 

(FDOT_Stanrdards_Features.dgnlib (Default)). These Feature Definitions are set up for 

various Design Stages. 
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4. Select the Handle of the SR 61 Corridor and locate the Properties icon when the menu 

displays. 

 

5. Select the Properties icon and change the Feature Defintion from 1 PRELIM to 2 DESIGN. 
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6. The Corridor will re-process and the 3D Model will re-draw with a tighter interval. Notice that 

the outside corridors remain unchanged. 
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7. Expand the OpenRoads Model section of the Explorer window. 

8. Expand MODLRD01.dgn (Default). 

9. Expand 1 PRELIM under Corridors. 

10. Right click on SR61 L and select “Properties.” 

11. Hold down Shift or Ctrl and select SR61 R. The Properties 

window changes to show both Corridors selected.  

 

 

 

 

12. Change the Feature Defintion from 1 PRELIM to 2 DESIGN as 

shown below. The 3D models for the outside corridors should 

redraw with a tighter interval. 
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Exercise 4.8 Add Corridor Key Stations, SR61 

Create Key Station tool is useful to add stations that are not coincident with the template interval.  When the 

median conditions change abruptly, it is desirable to include the station for processing. Otherwise the model may 

have holes or overlaps, which is not desirable when it is used to generate 3D Deliverables for Automated Machine 

Guidance (Refer to Chapter 10).  

1. Use the Corridors, Edits>Create Key Station tool. 

  

2. Identify the Corridor Boundary handle of the SR61 Corridor.  

3. Use AccuSnap to locate the Plan View CurbMedian / Traffic Separator division line. Snap 

to a point on this line 
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4. Repeat these steps for both Traffic Separator locations in the Plan View. 

 

5. Add Key Stations at other transition areas, including where the left turn lane transition begins. 

If snapping directly on the transition point does not work, sometimes a key station is needed 

immediately before and/or after the transition point in order to minimize the size of the hole. 

6. (Optional) Rotate the 3D 

View to a Top-down 

orientation, as it is 

sometimes easier to see 

where to snap to in the 3D 

view.  

  



Chapter 4 ____________________________________________ BASIC CORRIDORS MODELS - Review Corridor Objects, SR61 

FDOT Roadway Design and 3D Modeling ©2019 FDOT  4-25 

Exercise 4.9 Review Corridor Objects, SR61 

The Corridor Objects dialog is a summary of all Corridor Modeling objects and provides an excellent method 

of managing data. 

1. Use the Corridors, Corridor Objects tool. 

 

2. Identify the Corridor Boundary handle to open the Corridor Objects dialog. 

 

3. Review the various objects on the corridor. If too many key stations were added in the previous 

step, they can be deleted or modified in this dialog. 

➢ Additional Template Edits, SR61 

1. Add the sidewalk front and back lines as corridor references to the respective outside corridors. 

2. Change the sidewalk buffer from 3 feet to 0 feet on both roadways.  
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5 SUPERELEVATION 

OVERVIEW  

Production Support 

Office 

CAD DSuperelevation 
& Design Criteria 
(OpenRoads)
John-Mark Palacios, P.E.

2019

 

Superelevation rotates the pavement cross slopes through a curve so that vehicles can maintain stability and speed 

while on a turning roadway. Elevation banking is applied to help offset centrifugal force. Superelevation 

standards also define the transition length required to rotate from a normal crown to a fully banked curve and 

back again.  

Superelevation can be calculated in two ways:  

• Rules-based – using a set of preferences (SEP or SRL files) the station and associated cross slopes of the 

transitions are based on design speed, curvature, and other design parameters. As the design progresses and 

parameters change (i.e., design speed exceptions) superelevation can be reprocessed to the revised 

parameter(s).  

• Import – using a comma separate values (CSV) file to import the station and associated cross slope of each 

transition. In this option, the rules are not utilized; the data is simply applied to the superelevation lanes.  

The result of superelevation is a DGN file of graphic superelevation lanes with cross slope attributes. This file 

can be referenced to a corridor model and associated, so the superelevation transitions are incorporated into the 

corridor model. The superelevation data can be in its own DGN file, or can be drawn into any of the other project 

DGN files with geometry, corridor, etc.  
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HORIZONTAL AND VERTICAL GEOMETRY 

Horizontal and Vertical Geometry

Use FDOT Design Criteria checks

Remember standards as you design
• Horizontal:

• Tables:

• 210.8.1

• 210.8.2

• 210.8.3

• 210.9.1

• 210.9.2

• 210.9.3

• 211.7.1

• 224.10.1

• Sections:

• 210.8

• 210.9

• 211.7

• 211.8

• 224.10

• Vertical:
• Tables:

• 210.10.1

• 210.10.2

• 210.10.3

• 210.10.4

• 211.9.1

• 211.9.2

• 211.9.3

• Sections:

• 210.10

• 210.11

• 211.9

• 211.10

• 224.11

 

• Photo source:  Director X. (2015). Hotline Bling. Retrieved from  

https://www.youtube.com/watch?v=uxpDa-c-4Mc 

DATA NEEDED FOR FDM HORIZONTAL GEOMETRY 

Data Needed for FDM Horizontal 
Geometry

Superelevation 
eMax:

Low Speed (5%)

High Speed (10%)

Shared Use Path 
(2%)

Roadway Type

Arterial or 
Collector

Interstate and 
Ramps

Shared Use 
Path

Design Speed

18 mph - 70 mph

Construction 
Type

New 
Construction

RRR

 

• These are the data inputs you need to begin designing horizontal geometry.  

• For roadways there are only two possible max superelevations, and these depend on the speed classification 

of the roadway. Basically, the FDM defines low speed as 45 mph and below, and high speed anything faster.   

• Roadway type is determining which chapter of the FDM the software will be using: 210, 211, or 224. 

https://www.youtube.com/watch?v=uxpDa-c-4Mc
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DATA NEEDED FOR FDM VERTICAL GEOMETRY 

Data Needed for FDM Vertical 
Geometry

Roadway 
Type

Arterial or 
Collector

Freeways or 
Expressways

Interstate

Ramps

Shared Use Path

Context 
Classification

C1, C2

C2T, C3, C4

C5, C6 Urban

Limited Access

Design 
Speed

18 mph -
70 mph

Construction 
Type

New 
Construction

RRR

Cross Section

Curb and Gutter

Flush Shoulder

Shared Use 
Path Grade

Shared Use:
Flat to 5%

Bike Only:
>5%-9%

 

• These are the data inputs you need to begin designing vertical geometry 

• For the Shared Use Path criteria, we need the controlling grade (typically the steepest grade). 

• We had to make some assumptions and use some work arounds since ORD and Civil 3D are built primarily 

around the needs of designing a roadway. 

DATA NEEDED FOR SUPERELEVATION 

Data Needed for Superelevation (ORD)

Superelevation
eMax:

Low Speed 
(5%)

High Speed 
(10%)

Shared Use 
Path (2%)

Design Speed

18 mph - 70 
mph

Lanes
/Direction

1-2

3

4

Pivot Method

Crown

Edge

Divided Inside

Centerline

 

• Shared Use Path would typically be one of the “Edge” methods (inside, outside, left, right) 

• Undivided roadway would typically be Crown or Centerline 

• Divided roadway might be “Divided Inside” 
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CREATE FILE 

Create File (ORD)
ALGNRD file for both Alignment and Superelevation

 

• Superelevation goes in the Alignment file now.  

DESIGN STANDARDS 

Production Support 

Office 

CAD DDesign Standards
Open Design Standards Toolbar

 

• For horizontal alignment, you just pick the category and the appropriate design speed. 
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VERTICAL STANDARDS 

Production Support 

Office 

CAD DVertical Standards

 

• Notice how, for the vertical standard for roadway, you select basically the Context Classification and the 

design speed, but for Shared Use Paths you select the grade. Due to the limitations of the software, we can’t 

show a warning for every scenario. If you’re using this tool to do an alignment in ORD for a shared use path, 

I would recommend double checking the values and not relying too heavily on the warnings. Of course, that’s 

good practice in general. 

• You will have to pick whatever steepest grade applies, and if you want you can break the alignment up with 

different standards whenever a different profile grade applies. In general, the steepest downhill grade applies. 

• Select the design standards, then you can toggle it as the active design standard before drawing any 

alignments. 

REMOVE AND SET DESIGN STANDARD 

Production Support 

Office 

CAD DRemove and Set 
Design Standard

 

• The first button in the toolbar sets the standard for an existing alignment. If your alignment was already 

drawn with an active design standard, you used to be able to change the design standard without issue.  
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• In testing I have seen ORD fail to totally overwrite the standards doing it that way, so I would recommend 

removing the existing design standard first. Expand out all the dependencies to make sure there is nothing 

attached to individual lines or curves, either. 

• Once you have no design standard attached, select “Set Design Standard” in the Design Standard Toolbar, 

and then pick the alignment. 

TOGGLE ACTIVE DESIGN STANDARD 

Production Support 

Office 

CAD DToggle Active 
Design Standard

 

• Can run Complex by PI tool and it will automatically put in the radii. Select from Geometry tab, Horizontal 

section, choose Complex. 

 

Production Support 

Office 

CAD DComplex by PI

 

• You can see in this table that it is automatically putting in the minimum radius for the superelevation rate, 

286’ 
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WARNINGS 

Production Support 

Office 

CAD DWarnings

 

• But--see the warning symbol? 

• Warning symbol is for the arc length being shorter than the minimum value. 

• The table to the right shows the desired curve lengths, but the minimum is 400 ft. 

• If you use the “Desired curve length” horizontal standard, it will pick based on this standard. I would 

recommend using the “Desired Length” standards first, and then if you can’t meet the curve lengths due to 

constraints on your project, you can change your design standard to the “Min length” standard 

CIVIL MESSAGE CENTER 

Production Support 

Office 

CAD DCivil Message Center

 

• Hide the MicroStation notification and just display the warnings to see violations of horizontal geometry 

standards 

• Changing geometry is the same as it was in SS4, I won’t cover that. 
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VERTICAL DESIGN STANDARDS 

Production Support 

Office 

CAD DVertical Design 
Standards

 

• If you want to draw a new profile, make sure you have a vertical standard selected and Toggle Active Design 

Standard. Also, open a profile model for the alignment. 

• Then you can use the “Profile Complex by PI” tool in the Geometry > Vertical section and it will put the 

minimum K value in as you draw it. 

• Error messages work similarly as for horizontal geometry. 

REMOVE AND SET VERTICAL STANDARD 

Production Support 

Office 

CAD DRemove and Set 
Vertical Standard

 

• Apply standard to an existing vertical alignment 

• Remember to Remove existing standard first, then set design standard and pick the profile as on the right 
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SET SUPERELEVATION FLAGS IN TEMPLATE 

Set Superelevation Flags in Template

 

• Now we’re skipping ahead, you need your corridor model created before applying superelevation. 

• In the SS4 training we could get by with setting superelevation flags after calculating superelevation, but in 

ORD best practice is to set them ahead of time. This will allow us to use one of the new features I’m going 

to show you. Before creating superelevation lanes, you will want to make sure to set the Superelevation Flags 

accordingly by lane. Be sure to synchronize with the template library if needed. 

SUPERELEVATION POINTS 

Superelevation Points 

 

• If you’re going to use superelevation by lanes, you can go to “Active Template” and expand “Superelevation 

Points” to see all the points you have turned the superelevation flags on, which ORD will use to determine 

the lanes. 

• There are several new pivot points available in ORD, and to take advantage of them for a divided roadway 

you’ll want to create a null point on the centerline that the others are tied to, so the slope can be adjusted 

from there. Just use a vector offset 
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SUPERELEVATION SECTIONS 

Production Support 

Office 

CAD DSuperelevation
Sections

 

• Select Create in the Superelevation section in the corridors tab. 

• Select alignment 

• Name and give the Superelevation feature definition. 

• Minimum tangent length can split it into multiple sections (ie if you have multiple design speeds) based on 

the distance between curves. 

• Just like in SS4 it goes straight into the create superelevation lanes tool 

SUPERELEVATION LANES 

Production Support 

Office 

CAD DSuperelevation Lanes

 

• New feature lets you select your template in order to create superelevation lanes in accordance with the lanes 

in the template. 

• Can use context menu on sections or select from Superelevation section in the Corridors tab of the ribbon 

• Choose create by template and it will automatically pick up points based on how your template is set up 
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SUPERELEVATION LANES BY TEMPLATE 

Superelevation Lanes by Template

 

• Pick template 

CALCULATE SUPERELEVATION 

Production Support 

Office 

CAD DCalculate 
Superelevation

 

• Go to Corridor tab, Superelevation section. Click “Calculate.” 

• Select FDOT superelevation rule file 
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Production Support 

Office 

CAD DCalculate 
Superelevation

 

• Select appropriate settings, e selection is “Low Speed,” “High Speed,” or “Shared Use Path” 

Production Support 

Office 

CAD DCalculate 
Superelevation

 

• For Shared Use Path, select “Speed Table” under “L.” 

• For High Speed you need to know the lanes 

• Design speed varies based on e selection. For high speed we have 30-70 
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Production Support 

Office 

CAD DDesign Speed

 

• For Shared Use Paths we have 18 and 30, and for Low Speed we have 25-45 

Production Support 

Office 

CAD DPivot Method

 

• Here are the new pivot methods. Those should be pretty self-explanatory—just remember that your template 

needs to be set up in a way that allows for it 

• You can optionally open the superelevation editor when complete. The editor is the same as it was in SS4, 

so I’m not going to go over that part. But you can create a superelevation report to export the superelevation 

to a .csv file, then import it through the editor. This allows you to make corrections or calculations in Excel 

if you want to double check that the numbers meet the standards. 
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ASSIGN TO CORRIDOR 

Production Support 

Office 

CAD DAssign to Corridor

 

• Go back into your model file. Make sure you reference in the superelevation model from the alignment file 

into the the 2D model 

• From the Corridors tab, Superelevation section, select “Assign to Corridor.” 

• Select the Superelevation section and then the corridor, Verify the points in the dialog, and it should process 

when you click OK. 

Verify Superelevation

 

• Open a cross section view and verify that the superelevation has been applied 
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SUMMARY 

Production Support 

Office 

CAD D

Summary

• Applicable Standards

• Data for FDOT Workflow

• ORD Design Standards & Superelevation
• Alignment

• Superelevation

John-Mark Palacios

850-414-4720

John-Mark.Palacios@dot.state.fl.us

http://fdot.gov/cadd
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6 KEY SHEET  

OBJECTIVES 

• Create a Key Sheet DGN File 

• Setup Key Sheet with All Necessary Information 

KEY SHEET 

The Key Sheet is defined as the first sheet in the contract plans. The Key Sheet describes the project, the contents 

of the plans, and identifies those responsible for preparing the plans. All requirements for the Key Sheet, can be 

found in Part 3, Chapter 302 of the FDOT Design Manual (FDM). 

EXERCISE OVERVIEW  

6.1  Creating the Key Sheet 

6.2  Placing and Editing the Components of Plan Set List 

6.3  Creating and Placing the Key Sheet Index 

6.4  Placing the Range and Township Map Label 

6.5  Placing the Project Location Labels  

6.6  Placing the Contract Revision Note (Optional) 

6.7  Indexing the Key Sheet 
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Exercise 6.1 Creating the Key Sheet 

In this exercise, the Key Sheet DGN file will be created, the sheet will be placed with a map, and all of the 

necessary information will be added to the sheet. 

1. Using the FDOT - Roadway icon on your desktop, open the MicroStation design file:   

C:\Worksets\FDOT\FLUG_2019\_BlankFile.dgn 

 

2. On the OpenRoads Modeling Workflow, select Create File, from the FDOT Tab 

  

3. The Create File (v 2.0) dialog displays. On the Create File dialog set the Discipline to 

Roadway and File Group to Roadway Files. From the File Type list, select KEYSRD. On the 

Output File section of the dialog, be sure to set the County to Wakulla. Once everything is set 

up to match the image below, click Create – Open File to create and open the Roadway Key 

Sheet file. Click Close to close the Create File (v 2.0) dialog. 
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4. Once in the file, download the PDF county map using the County Maps link on the FDOT Tab. 

FDOT Links>County Maps. Scroll to Wakulla and download the Waku-c.pdf to the rwmap 

folder within your workset. 

 

Note All Florida County Maps can be found in MicroStation DGN format and PDF format at: 
http://www.fdot.gov/geospatial/countymap.shtm 

5. Navigate to the Home tab and select References from the Attach Tools button. 

   

http://www.fdot.gov/geospatial/countymap.shtm
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a. Attach the waku-c.pdf as a reference, setting the Detail Scale: Full Size 1 = 1 

 

b. Fit view and the zoom into the project location, which is the intersection of SR 61 and 

US 98. 

6. Navigate to the Drawing Production tab and select the Place Named Boundary tool. 

 

a. Fill out the Place Named Boundary dialog as shown below 
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b. Place the named boundary in the drawing with the project location in the middle. 

 

c. Once the named boundary is placed, the Create Drawing dialog will display. Fill this 

out as shown below, making sure the Drawing Model annotation scale matches the 

Detail Scale set on the Place Named Boundary dialog. Once filled out, click OK to 

create the Key Sheet. 

 

Note There is a Bentley display bug with the map showing up. You may need to zoom in and then out to get the 
map to show. 



KEY SHEET - Creating the Key Sheet __________________________________________________________________ Chapter 6 

6-6 ©2019 FDOT FDOT Roadway Design and 3D Modeling 

7. On the Drawing Production tab, use the Edit Text tool to enter the information GOVERNING 

STANDARD PLANS as 2019-20. 

 

 

a. Use the Edit Text tool to enter the information GOVERNING STANDARD 

SPECIFICATIONS as July 2019. 

 

b. Use the Edit Text tool to enter the Construction Contract No. as T-8888. 

 

c. Use the Edit Text tool to enter the Fiscal Year Value as 19. 

 

d. Use the Edit Text tool to enter the FDOT Project Manager. 
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e. Use the Edit Text tool to fill out the ROADWAY PLANS ENGINEER OF RECORD 

information. 

 

f. Finally, use the Edit Text tool to enter the Section Number and STATE ROAD NO., as 

shown below. 
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Exercise 6.2 Placing and Editing the Components of Contract Plans Set list 

The Components of Contract Plans Set is a list of all the components included in the plan set. This exercise 

demonstrates how to add this list to the Key Sheet. 

1. Once the Key Sheet has been created, right-click and hold to bring up the context menu. From 

the context menu, select Component List. 

  

2. The MicroStation Place Active Cell command launches with KNComponentsList set as the 

Active Cell. 

  

3. Data Point at the upper left corner of the Key Sheet border to place the cell. 

4. The text appears under the COMPONENTS OF CONTRACT PLANS SET on the Key Sheet. 

5. To edit the list of components, double-click on the text. 

6. Edit the list in the Text Editor dialog. This project should include plans for the following 

components: 

✓ ROADWAY PLANS 

✓ SIGNING AND PAVEMENT MARKING PLANS 

✓ SIGNALIZATION PLANS 

7. Data point in MicroStation when finished editing the text. 
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Exercise 6.3 Creating and Placing the Key Sheet Index 

1. On the FDOT Tab, select LDM from the Actions group. 

 

2. On the Linked Data Manager dialog, select the Create new link button. 

 



KEY SHEET - Creating and Placing the Key Sheet Index ___________________________________________________ Chapter 6 

6-10 ©2019 FDOT FDOT Roadway Design and 3D Modeling 

3. From the Link Information dialog, select Create New from Template. On the Select FDOT 

Template dialog select the Sheet Index - Roadway from the Text Notes category. Click OK 

and save the KSIndexRoadway.txt file in your roadway folder. 

 

a. Once saved and back on the Link Information dialog, click OK to place the Index. 
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b. Place the Index so that it lines up with the SHEET NO. and SHEET DESCRIPTION 

headers. 

 

c. Once this is placed in the file, the Index will be modified within the actual text file and 

not in the ORD dgn file. To get to the Index text file, from within Linked Data Manager, 

right-click on the Link and select Open Source. 
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Exercise 6.4 Placing the Range and Township Map Label 

This exercise describes how to place township and range labels on a key sheet. This is a requirement for the Key 

Sheet.  

Note The Range and Township labels should be known from the Scope of Work. This information can also 
be found within the county map pdf file.  

1. With the Element Selection tool active, right-click and hold to bring up the Context Menu. On 

the Context Menu, select Range Map Label.  

  

2. The MicroStation Place Active Cell command launches with KMLabelRange set as the 

Active Cell. 

  

3. Data point to place the Range Map Label at the correct locations around the map. Place as 

many labels as needed. Reset when finished placing labels. 
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4. Select the Edit Text tool  to edit the labels.  See the image below for the correct Range 

Values and Locations. 

 

5. With the Element Selection tool active, right-click and hold to bring up the Context Menu. On 

the Context Menu, select Township Map Label. 
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6. The MicroStation Place Active Cell command launches with KMLabelTnshp set as the 

Active Cell. 

  

7. Data point to place the Township Map Label at the correct locations around the map. Reset 

when finished placing labels.  

8. Select the Edit Text tool  to edit the labels.  See the image below for the correct 

Township Values and Locations. 
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Exercise 6.5 Placing the Project Location Labels 

This exercise will demonstrate how to add the Begin and End Project Note. 

1. Select the Place Note tool, from the Notes Group on the Drawing Production tab. On the Place 

Note dialog, set the Dimension Style to _FDOT_KeySheet_BeginProject. Fill the rest out as 

shown below. 

 

a. Fill out the Text Editor dialog as shown below. 

 

b. Position the terminator in the desired location 

c. Data point to place the terminator 

d. Position the note in the desired location 

e. Data point to place the note 

2. Repeat the same process, using the _FDOT_KeySheet_EndProject Dimension Style, to place 

the End Project Note.  

✓ END PROJECT 

✓ STA. 726+45.00 

✓ MP 9.824 
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3. There is another Project Location label that is required for the Key Sheet that points to the 

Florida map. From the Drawing Production Tab, select Place Note. 

4. Set the Place Note Parameters as shown below, with the Dimension Style set to 

_FDOT_Key_Sheet_Locate: 

 

5. Type PROJECT LOCATION into the Text Editor, select the general project location on 

the Florida map, position the label, and data point again to place it.  The label should display 

as shown below. 
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Exercise 6.6 Placing the Contract Revision Note (Optional) 

The Contract Plans Revision Note is only placed into the file to document which Component and which Sheets 

have been revised throughout the project. If there are no revisions this is not required. 

1. With the Element Selection tool active, right-click and hold to bring up the Context Menu. On the 

Context Menu, select Contract Plans Revision Note. 

 

2. The MicroStation Place Active Cell command launches with KNContractRev set as the Active Cell. 

 

3. Data point to the lower left corner of the Key Sheet border. The Note should display as shown. 
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4. Select the Edit Text  tool to enter the Financial Project ID, 220495-5-52-01 as well as the 

Revision Number, the Component Set, the Revised Page Numbers, and Date of Revision. See below. 

 

5. Go to the MicroStation View options and turn Off Data Fields.  

 

6. Fit View in MicroStation. 

7. Select File > Save Setting. 
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Exercise 6.7 Indexing the Key Sheet 

1. Continuing in the KEYSRD01.dgn file, go to the Home Tab, select the Explorer tool from 

the Primary Group 

 

2. Select the Sheet Index and then click on the Open Sheet Index for Edit button. 

 

3. With the Sheet Index open for editing, expand out the Index to view the folders for each 

discipline. 
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4. From the Home Tab, select the Models tool from the Primary Group  

  

5. With the Models dialog open, drag and drop the SR61 [Sheet] model onto the Roadway folder 

within the Sheet Index. 
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6. Select the Manage Sheet Index tool, from the Sheet Index tab in Explorer. 

  

7. On the Manage Sheet Index dialog, fill out the Miscellaneous as shown below. 

 

8. Click OK. 
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7 PLAN AND PROFILE SHEETS 

Part 3, Chapter 312 of the FDOT Design Manual (FDM) outlines Florida Department of Transportation (FDOT) 

Roadway Plan and Roadway Plan-Profile Sheets. The Roadway plan sheets show the project’s complete 

horizontal alignment. The plan-profile sheets show the project’s complete horizontal and vertical alignment. 

Various Roadway elements such as pavement width, medians, paved shoulders, curbs, drainage elements, tapers, 

turn provisions, and intersecting roadways, are also shown on these sheets. 

OBJECTIVES 

• Create and annotate plan and profile sheets 

• Setup Key Sheet with All Necessary Information 

EXERCISE OVERVIEW  

7.1  Creating Plan Sheets 

7.2  Creating Plan and Profile Sheets 

7.3  Creating Cross Section Sheets 
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Exercise 7.1 Creating Plan Sheets 

1. Use the FDOTConnect for OpenRoads Designer icon to open the 

C:\Worksets\FDOT\FLUG_2019\PLANRD01.dgn file 

2. Select Drawing Production > Annotations > Element Annotation > Annotate Element. Left 

click on the CL_SR61 alignment to select it and then right click to accept and annotate the 

alignment. 

3. From the Drawing Production tab, select the Place Named Boundary tool. 

Drawing Production > Named Boundaries > Named Boundary > Place Named Boundary 

a. Select the Civil Plan mode. 

b. Set Drawing Seed to Plan Only 

c. In the 2D view, select the CL_SR61 alignment along which the plan named boundaries 

will be created. 

d. Fill out the dialog, as shown 

 

e. Follow the prompts in the lower left corner left click to define the named boundaries. 

Multiple left clicks may be required. 

f. Two or three clicks are required to (1) accept the Start Location, (2) accept the Stop 

Location, and (3) create the Named Boundaries. However, if the Start or Stop Location 

are selected graphically one or more of these clicks has already been completed. 

g. On the Create Drawing dialog, click OK to create the sheets. 
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Exercise 7.2 Creating Plan and Profile Sheets 

1. Use the FDOTConnect for OpenRoads Designer icon to open the 

C:\Worksets\FDOT\FLUG_2019\PLPRRD01.dgn file 

2. Select Drawing Production > Annotations > Element Annotation > Annotate Element. Left 

click on the CL_SR61 alignment to select it and then right click to accept and annotate the 

alignment. 

3. Create Named Boundaries for the plan portion of the sheets. 

a. Select Drawing Production > Named Boundaries > Named Boundary > Place Named 

Boundary. 

b. Select the Civil Plan mode. 

c. Set Drawing Seed to Plan over Profile - Top 

d. In the 2D view, select the CL_SR61 alignment along which the plan named boundaries 

will be created. 

e. Fill out the dialog, as shown, making sure that Create Drawing is unchecked. 

 

f. Follow the prompts in the lower left corner left click to define the named boundaries. 

Multiple left clicks may be required. A total of two clicks are required to (1) accept the 

Start Location, (2) accept the Stop Location, and (3) create the Named Boundaries. 

However, if the Start or Stop Location are selected graphically one or more of these 

clicks has already been completed. 
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4. Create Named Boundaries for the profile portion of the sheets. 

a. Open a profile view for the CL_SR61 alignment. This can be done using the right click 

View Control context menus. 

b. Select Drawing Production > Named Boundaries > Named Boundary > Place Named 

Boundary 

c. Select the Civil Profile mode. 

d. Set Drawing Seed to Plan over Profile - Bottom 

e. In the profile view, select the profile along which the named boundaries will be created. 

f. Fill out the dialog, as shown below, this time making sure that Create Drawing is 

enabled. 

 

g. Follow the prompts in the lower left corner left click to define the named boundaries. 

Multiple left clicks may be required 

h. On the Create Drawing dialog, click OK to create the sheets. 
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Exercise 7.3 Creating Cross Section Sheets 

1. Use the FDOTConnect for OpenRoads Designer icon to open the 

C:\Worksets\FDOT\FLUG_2019\RDXSRD01.dgn file 

2. Create Named Boundaries which define the location and extent of each cross section. 

 Both the 2D and the 3D models must be open in a view to create cross sections. 

a. Select Drawing Production > Named Boundaries > Named Boundary > Place Named 

Boundary. 

b. Select the Civil Cross Section mode. 

c. Set Drawing Seed to CrossSection20Scale 

d. In the 2D view, select the CL_SR61 alignment along which the cross section named 

boundaries will be created. 

e. Set the Start Location to 700+00 and the Stop Location to 715+00. the dialog should 

be filled out as shown below. The settings from the Left Offset down are set based on 

the applied Drawing Seed. 

 

f. Follow the prompts in the lower left corner left click to define the named 

g. boundaries. Multiple left clicks are probably required. Once the named boundaries are 

created they appear in the 3D view. 

h. Click OK on the Create Drawing dialog to create the sheets. 
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